FC 721
Fire control panel
Technical Manual

IP 7
Imprint

Technical specifications and availability subject to change without notice.

Transmittal, reproduction, dissemination and/or editing of this document as well as utilization of its contents and communication thereof to others without express authorization are prohibited. Offenders will be held liable for payment of damages. All rights created by patent grant or registration of a utility model or design patent are reserved.

Issued by:
Siemens Switzerland Ltd.
Building Technologies Division
International Headquarters
Theilerstrasse 1a
CH-6300 Zug
Tel. +41 58 724-2424
www.siemens.com/buildingtechnologies

Edition: 2018-06-25
Document ID: A6V10211100_g_en--

© Siemens Switzerland Ltd, 2009
# Table of contents

1 About this document ............................................................................................... 7  
  1.1 Applicable documents .................................................................................. 9  
  1.2 Download center ......................................................................................... 9  
  1.3 Technical terms and abbreviations ............................................................. 9  
  1.4 Revision history ..........................................................................................10  
  1.5 How displays are represented in the document ...........................................12  
2 Safety .............................................................................................................. 13  
  2.1 Safety instructions ......................................................................................13  
  2.2 Safety regulations for the method of operation ...........................................14  
  2.3 Standards and directives complied with .....................................................16  
  2.4 Release Notes ..............................................................................................17  
  2.5 PIN guidelines .............................................................................................17  
  2.6 Cyber security disclaimer ..........................................................................18  
3 Options with requirements .............................................................................. 19  
4 System overview ............................................................................................ 20  
  4.1 Station types ..............................................................................................21  
5 Planning .......................................................................................................... 22  
  5.1 FC721 system limits and options .................................................................22  
  5.2 Functions ....................................................................................................23  
    5.2.1 Defining controls ..............................................................................24  
6 Mounting ........................................................................................................... 25  
  6.1 Mounting and assembling a station ...............................................................25  
  6.2 Mounting instructions ................................................................................26  
    6.2.1 Surface-mounted assembly ................................................................27  
    6.2.2 Mounting and wiring the operating unit ...........................................30  
  6.3 LED module ................................................................................................33  
  6.4 EVAC-NL operating unit FTO2007-N1 [NL] (FC 721-HZ only) ...................34  
  6.5 Options .......................................................................................................35  
    6.5.1 Fitting extra relay ..............................................................................35  
    6.5.2 Installing an RS232/RS485 module ......................................................36  
    6.5.3 Install shield connection terminal blocks .........................................40  
    6.5.4 Cable kit (communication) .................................................................41  
    6.5.5 Insert license key ...............................................................................42  
    6.5.6 19" mounting kit ..............................................................................42
Installation .......................................................................................... 44
7.1 Protection elements ........................................................................... 45
7.2 Supply concept .................................................................................. 45
7.2.1 Operation with battery backup ..................................................... 46
7.2.2 Operation without battery backup ................................................ 46
7.3 Position of printed circuit boards / components .................................. 47
7.4 Power supply - mains voltage connection .......................................... 48
7.4.1 Emergency power supply ............................................................ 51
7.4.2 Batteries ..................................................................................... 52
7.4.3 Periphery board .......................................................................... 54
7.5 C-NET detector line ........................................................................... 59
7.5.1 Connectable C-NET devices ....................................................... 59
7.5.2 Connectable 'voice sounder beacon/voice sound. beacon base' devices ................................................................................................... 63
7.5.3 C-NET topology and connection .................................................. 64
7.5.4 Wiring principle behind C-NET devices ....................................... 67
8 Structure and function ....................................................................... 68
8.1 Indication and operating elements .................................................... 68
8.2 Extra indication and operating devices .............................................. 70
8.2.1 Mimic display driver FT2001 ....................................................... 71
8.3 Connecting external alarm indicators ............................................... 71
8.4 Software ............................................................................................ 72
9 Operation functions .......................................................................... 73
9.1 Selection and opening / execution ..................................................... 73
9.2 Scrolling ............................................................................................ 73
9.3 Indication of the position and length of the list ................................... 74
9.4 Shortcut ............................................................................................. 74
9.5 Favorites ........................................................................................... 74
9.6 Entry of numbers and letters ............................................................ 75
10 Connectivity and communication with 'Station' .................................. 76
10.1 Setting Windows firewall .................................................................. 76
10.1.1 Windows XP ............................................................................. 76
10.1.2 Windows 7 / Windows 8 / Windows 10 ...................................... 77
10.2 Connecting the PC to the station ....................................................... 78
10.3 Disconnecting the PC from the station ............................................. 79
10.4 Loading data to the 'Station' ............................................................. 79
10.5 Initializing 'Station' ........................................................................... 80
10.6 Loading configuration from the PC to the station ......................... 82
10.7 Loading configuration from the station to the PC ......................... 84
10.8 Creating a backup of the 'Site' configuration .................................... 84
11 Commissioning .................................................................................. 86
11.1 Activating access level........................................................................ 87
  11.1.1 Log in / Change access level....................................................... 87
11.2 Auto-configuration of control panels ............................................. 88
  11.2.1 Auto-configure line .................................................................. 88
11.3 Displaying C-NET devices ............................................................... 91
11.4 Entering/Changing customer text .................................................. 92
11.5 Setting the system time ................................................................... 93
  11.5.1 Setting time and date ................................................................. 93
11.6 Changing access authorization PIN ................................................ 94
  11.6.1 PIN administration .................................................................... 94
11.7 Restart the station............................................................................ 96
11.8 Calibrating an FDnet/C-NET detector line ....................................... 97
  11.8.1 Automatic line calibration ......................................................... 99
  11.8.2 Manual line calibration ............................................................. 99
  11.8.3 Calibration report .....................................................................100
11.9 Detailed commissioning steps ..........................................................105
  11.9.1 Preparing 'Station' for commissioning .......................................105
  11.9.2 Preparing 'Station' for commissioning - without BDV installation 106
  11.9.3 Auto-configuring 'Station' ..........................................................106
  11.9.4 Auto-configuring the detector line ............................................107
  11.9.5 Loading automatically created configuration to the PC ............108
  11.9.6 Adapting configuration ...............................................................108
  11.9.7 Switch off ................................................................................108
  11.9.8 Switching on ...........................................................................109
  11.9.9 Restarting the detector line .......................................................110
  11.9.10 Freezing outputs ....................................................................110
  11.9.11 Enabling frozen outputs .........................................................111
  11.9.12 Read in devices on detector line .............................................111
  11.9.13 Detaching the device...............................................................111
  11.9.14 Delete the device on Person Machine Interface .....................112
  11.9.15 Remove the elements .............................................................112
  11.9.16 Testing detectors ....................................................................112
  11.9.17 Switching on test mode ..........................................................113
  11.9.18 Switch on normal operation ...................................................114
  11.9.19 Rectify localization errors .......................................................115
  11.9.20 Checking 'Site' function ..........................................................115
  11.9.21 Carrying out final commissioning work ...................................115
12 Remove or replace non-stationary C-NET devices .................................................. 116
12.1 Temporarily remove an individual non-stationary C-NET device............... 116
12.2 Temporarily removing multiple non-stationary devices ................................. 116
   12.2.1 Switch off zone .................................................................................. 117
   12.2.2 Removing devices, performing tasks and re-inserting devices ............ 117
   12.2.3 Switch on zone .................................................................................. 117
12.3 Permanently removing non-stationary C-NET devices................................. 118
12.4 Replacing non-stationary C-NET devices of the same type ......................... 118
   12.4.1 Replacing the C-NET device .............................................................. 118
12.5 Replacing non-stationary C-NET devices of different types .......................... 119
   12.5.1 Removing the C-NET device .............................................................. 119
   12.5.2 Installing the C-NET device ............................................................... 119
   12.5.3 Replacing C-NET device in the 'Zone' .............................................. 119
13 Testing the installation .................................................................................... 120
13.1 Testing ......................................................................................................... 120
13.2 Checking functions ...................................................................................... 121
Glossary ............................................................................................................. 122
Index ............................................................................................................... 125
1 About this document

Goal and purpose
The information provided in this technical manual is a summary of the key procedures and functions required to assemble, install, commission, and service the FC721 fire control panel system.
The aim of this technical manual is to provide experienced and qualified personnel with a quick guide to the necessary processes.

Scope
This technical manual is a supplement to the documents provided for the Cerberus PRO fire detection system FS720 and applies for the following products:
- Fire control panel FC721

The information contained in this document is valid for introduction package IP7.

Target groups
The information in this document is intended for the following target groups:

<table>
<thead>
<tr>
<th>Target group</th>
<th>Activity</th>
<th>Qualification</th>
</tr>
</thead>
</table>
| System owner          | According to EN 50110-1, 'nominated person with the overall responsibility to ensure the safe operation of the electrical installation by setting rules and organisation or framework.' | 'This person can be the owner, employer, proprietor or a delegated person.'
|                       |                                                                          | 'Some of these duties can be delegated to others as required. For large or complex electrical installations or networks, the duties can be delegated for parts of the installations or the network.' |
| Installation personnel| Assembles and installs the product components at the place of installation. | Has received specialist training in the area of building installation technology or electrical installations. |
|                       | Carries out a function check following installation.                    |                                                                                |
| Commissioning personnel| Configures the product at the place of installation according to customer-specific requirements. | Has obtained suitable specialist training for the function and for the products. |
|                       | Checks the product operability and releases the product for use by the operator. | Has attended the training courses for commissioning personnel. |
|                       | Searches for and corrects malfunctions.                                  |                                                                                |
| Operating personnel   | Carries out procedures to correctly operate the product.                | No particular basic training is needed.                                        |
|                       |                                                                          | Has been instructed by the commissioning personnel.                           |
| Maintenance personnel | Carries out all maintenance work.                                        | Has obtained suitable specialist training for the function and for the products. |
Source language and reference document
- The source/original language of this document is German (de).
- The reference version of this document is the international version in English.
  The international version is not localized.

Document identification
The document ID is structured as follows:

<table>
<thead>
<tr>
<th>ID code</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID_ModificationIndex_Language_COUNTRY -- = multilingual or international</td>
<td>A6V10215123_a_de_DE</td>
</tr>
<tr>
<td></td>
<td>A6V10215123_a_en--</td>
</tr>
<tr>
<td></td>
<td>A6V10315123_a----</td>
</tr>
</tbody>
</table>

Date format
The date format in the document corresponds to the recommendation of international standard ISO 8601 (format YYYY-MM-DD).

Conventions for text marking
Markups
Special markups are shown in this document as follows:

<table>
<thead>
<tr>
<th>Markup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶</td>
<td>Requirement for a behavior instruction</td>
</tr>
<tr>
<td>1. 2.</td>
<td>Behavior instruction with at least two operation sequences</td>
</tr>
<tr>
<td>-</td>
<td>Version, option, or detailed information for a behavior instruction</td>
</tr>
<tr>
<td>⇨</td>
<td>Intermediate result of a behavior instruction</td>
</tr>
<tr>
<td>⇢</td>
<td>End result of a behavior instruction</td>
</tr>
<tr>
<td>●</td>
<td>Numbered lists and behavior instructions with an operation sequence</td>
</tr>
<tr>
<td>[ X ]</td>
<td>Reference to a page number</td>
</tr>
<tr>
<td>’Text‘</td>
<td>Quotation, reproduced identically</td>
</tr>
<tr>
<td>&lt;Key&gt;</td>
<td>Identification of keys</td>
</tr>
<tr>
<td>&gt;</td>
<td>Relation sign and for identification between steps in a sequence, e.g., 'Menu bar' &gt; 'Help' &gt; 'Help topics'</td>
</tr>
<tr>
<td>↑ Text</td>
<td>Identification of a glossary entry</td>
</tr>
</tbody>
</table>

Supplementary information and tips
The 'i' symbol identifies supplementary information and tips for an easier way of working.
1.1 Applicable documents

<table>
<thead>
<tr>
<th>Document ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A6V10210355</td>
<td>System description</td>
</tr>
<tr>
<td>A6V10210362</td>
<td>Planning</td>
</tr>
<tr>
<td>A6V10210390</td>
<td>Mounting / Installation</td>
</tr>
<tr>
<td>A6V10210416</td>
<td>Commissioning / Maintenance / Troubleshooting</td>
</tr>
<tr>
<td>A6V10210424</td>
<td>Configuration</td>
</tr>
<tr>
<td>A6V10229261</td>
<td>List of compatibility</td>
</tr>
<tr>
<td>A6V10210368</td>
<td>Product data</td>
</tr>
</tbody>
</table>

1.2 Download center

You can download various types of documents, such as data sheets, installation instructions, and license texts via the following Internet address:

https://siemens.com/bt/download

- Enter the document ID in the search field.

You will also find information about search variants and links to mobile applications (apps) for various systems on the home page.

1.3 Technical terms and abbreviations

You will find details of technical terms and abbreviations in the 'Glossary' chapter.
1.4 Revision history

The reference document's modification index applies to all languages into which the reference document is translated.

The first edition of a language version or a country variant may, for example, have the modification index 'd' instead of 'a' if the reference document already has this modification index.

The table below shows this document's revision history:

<table>
<thead>
<tr>
<th>Version</th>
<th>Edition date</th>
<th>Brief description</th>
</tr>
</thead>
<tbody>
<tr>
<td>g</td>
<td>2018-06-25</td>
<td><strong>Edition: Introduction Package IP 7</strong>&lt;br&gt;New&lt;br&gt;● PIN guidelines [→ 17]&lt;br&gt;● Integration of AD18 sounders in new chapter 'Connectable 'voice sounder beacon/voice sound beacon base' devices [→ 63]'&lt;br&gt;● Calibrating an FDnet/C-NET detector line [→ 97]&lt;br&gt;● Options with requirements [→ 19]&lt;br&gt;<strong>Changes and additions</strong>&lt;br&gt;● 'Connecting the PC to the station [→ 78]', 'Changing access authorization PIN [→ 94]', 'PIN administration [→ 94]',&lt;br&gt;● Batteries [→ 52], battery type FHA2006, 26 Ah replaced by type 'BAT12-25', 25 Ah</td>
</tr>
<tr>
<td>f</td>
<td>2015-12-15</td>
<td><strong>Edition: Introduction Package IP 6</strong>&lt;br&gt;New: Freezing outputs&lt;br&gt;Enabling frozen outputs&lt;br&gt;Switching off, Safety during switch-off, Switching on&lt;br&gt;Glossary entries in the text marked with '↑'&lt;br&gt;Cyber security disclaimer&lt;br&gt;<strong>Revised:</strong>&lt;br&gt;Referenced documents updated&lt;br&gt;Connectable C-NET devices updated&lt;br&gt;LED indicator (internal) FTO2002 replaced by LED module FTO2008, and red and yellow LED replaced by red/green and yellow LED&lt;br&gt;Loading data to the 'Station'&lt;br&gt;Loading configuration from the PC to the 'Station'&lt;br&gt;Loading configuration from the 'Station' to the PC&lt;br&gt;Creating a backup of the 'Site' configuration&lt;br&gt;Information regarding freezing outputs added to chapters 'Loading configuration from the PC to the 'Station'' and 'Restarting the detector line'&lt;br&gt;Initializing 'Station'&lt;br&gt;Switching off the detector line, Switching off a zone&lt;br&gt;Information on PIN configuration in Engineering Tool added to the 'PIN administration' chapter&lt;br&gt;C-NET detector line updated</td>
</tr>
<tr>
<td>e</td>
<td>2014-02-10</td>
<td>Information on voltage ranges revised in the chapter 'Configurable inputs/outputs'</td>
</tr>
<tr>
<td>Version</td>
<td>Edition date</td>
<td>Brief description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| d       | 2013-11-14   | **Edition: Introduction Package IP5**  
- Change to date format according to ISO 8601  
- C-NET devices added: FDCI723, FDM223-Ex, OOH740-A9-Ex, FDCL221-Ex, FDA221, FDA241, FDM273  
- License key (S1) replaces license key (L1)  
**CPR replaces CPD:** The Construction Products Regulation (CPR 305/2011) replaces the previous Construction Products Directive (CPD 89/106). |
| c       | 06.2012      | **Edition: Introduction Package IP4**  
- C-NET devices updated  
Revised:  
- General commissioning steps  
New chapter:  
- Chap. 'Connectivity and communication with 'Station' |
| b       | 07.2010      | **Edition for MP3.0 XS**  
- Amendments to MP3.0  
- Amendments to PMI & mainboard FCM2027  
- Various minor changes  
- Naming amended |
| a       | 05.2009      | Technical Manual FC721 |
1.5 How displays are represented in the document

With very few exceptions, the fire control panels and fire terminals are displayed in this document in tables.

Deviations between the original and the table are indicated by means of examples in the figures below:

![Figure 1: Display with window and bar](image)

### Table representation: Display without window

<table>
<thead>
<tr>
<th>Main menu</th>
<th>Access level 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit with &lt;C&gt;</td>
<td></td>
</tr>
<tr>
<td>Message summary</td>
<td>(1) Element search (5)</td>
</tr>
<tr>
<td>Functions</td>
<td>(2) Event memory (6)</td>
</tr>
<tr>
<td>Favorites</td>
<td>(3) Login/logout (7)</td>
</tr>
<tr>
<td>Topology</td>
<td>(4) Settings/administration (8)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>LED test</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>All</td>
<td></td>
</tr>
</tbody>
</table>

### Table representation: 'Select element category' window without bar

<table>
<thead>
<tr>
<th>Selecting element category</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone</td>
<td>(1)</td>
</tr>
<tr>
<td>Section</td>
<td>(2)</td>
</tr>
<tr>
<td>Area</td>
<td>(3)</td>
</tr>
<tr>
<td>Sounder</td>
<td>(4)</td>
</tr>
<tr>
<td>Physical channel</td>
<td>(5)</td>
</tr>
</tbody>
</table>

The table representation has the following key deviations from the original:

- Font and representation (not inverted)
- Windows are indicated separately without display background
- No bars to indicate the position and list length
- No frame around selection
2 Safety

2.1 Safety instructions

The safety notices must be observed in order to protect people and property. The safety notices in this document contain the following elements:
- Symbol for danger
- Signal word
- Nature and origin of the danger
- Consequences if the danger occurs
- Measures or prohibitions for danger avoidance

Symbol for danger

This is the symbol for danger. It warns of risks of injury. Follow all measures identified by this symbol to avoid injury or death.

Additional danger symbols

These symbols indicate general dangers, the type of danger or possible consequences, measures and prohibitions, examples of which are shown in the following table:

<table>
<thead>
<tr>
<th>General danger</th>
<th>Explosive atmosphere</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage/electric shock</td>
<td>Laser light</td>
</tr>
<tr>
<td>Battery</td>
<td>Heat</td>
</tr>
</tbody>
</table>

Signal word

The signal word classifies the danger as defined in the following table:

<table>
<thead>
<tr>
<th>Signal word</th>
<th>Danger level</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>'DANGER' identifies a dangerous situation, which will result directly in death or serious injury if you do not avoid this situation.</td>
</tr>
<tr>
<td>WARNING</td>
<td>'WARNING' identifies a dangerous situation, which may result in death or serious injury if you do not avoid this situation.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>'CAUTION' identifies a dangerous situation, which could result in slight to moderately serious injury if you do not avoid this situation.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>'NOTICE' identifies a possibly harmful situation or possible damage to property that may result from non-observance. 'NOTICE' does not relate to possible bodily injury.</td>
</tr>
</tbody>
</table>
How risk of injury is presented
Information about the risk of injury is shown as follows:

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nature and origin of the danger</strong></td>
</tr>
<tr>
<td>Consequences if the danger occurs</td>
</tr>
<tr>
<td>• Measures / prohibitions for danger avoidance</td>
</tr>
</tbody>
</table>

How possible damage to property is presented
Information about possible damage to property is shown as follows:

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nature and origin of the danger</strong></td>
</tr>
<tr>
<td>Consequences if the danger occurs</td>
</tr>
<tr>
<td>• Measures / prohibitions for danger avoidance</td>
</tr>
</tbody>
</table>

2.2 Safety regulations for the method of operation

National standards, regulations and legislation
Siemens products are developed and produced in compliance with the relevant European and international safety standards. Should additional national or local safety standards or legislation concerning the planning, mounting, installation, operation or disposal of the product apply at the place of operation, then these must also be taken into account together with the safety regulations in the product documentation.

Electrical installations

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Electrical voltage</strong></td>
</tr>
<tr>
<td>Electric shock</td>
</tr>
<tr>
<td>• Work on electrical installations may only be carried out by qualified electricians or by instructed persons working under the guidance and supervision of a qualified electrician, in accordance with the electrotechnical regulations.</td>
</tr>
<tr>
<td>• Wherever possible disconnect products from the power supply when carrying out commissioning, maintenance or repair work on them.</td>
</tr>
<tr>
<td>• Lock volt-free areas to prevent them being switched back on again by mistake.</td>
</tr>
<tr>
<td>• Label the connection terminals with external voltage using a 'DANGER External voltage' sign.</td>
</tr>
<tr>
<td>• Route mains connections to products separately and fuse them with their own, clearly marked fuse.</td>
</tr>
<tr>
<td>• Fit an easily accessible disconnecting device in accordance with IEC 60950-1 outside the installation.</td>
</tr>
<tr>
<td>• Produce earthing as stated in local safety regulations.</td>
</tr>
</tbody>
</table>
CAUTION

Noncompliance with the following safety regulations
Risk of injury to persons and damage to property
□ Compliance with the following regulations is required.

□ Specialist electrical engineering knowledge is required for installation.
□ Only an expert is permitted to carry out installation work.
Incorrect installation can take safety devices out of operation unbeknown to a layperson.

Mounting, installation, commissioning and maintenance
□ If you require tools such as a ladder, these must be safe and must be intended for the work in hand.
□ When starting the fire control panel ensure that unstable conditions cannot arise.
□ Ensure that all points listed in the 'Testing the product operability' section below are observed.
□ You may only set controls to normal function when the product operability has been completely tested and the system has been handed over to the customer.

Testing the product operability
□ Prevent the remote transmission from triggering erroneously.
□ If testing building installations or activating devices from third-party companies, you must collaborate with the people appointed.
□ The activation of fire control installations for test purposes must not cause injury to anyone or damage to the building installations. The following instructions must be observed:
- Use the correct potential for activation; this is generally the potential of the building installation.
- Only check controls up to the interface (relay with blocking option).
- Make sure that only the controls to be tested are activated.
□ Inform people before testing the alarm devices and allow for possible panic responses.
□ Inform people about any noise or mist which may be produced.
□ Before testing the remote transmission, inform the corresponding alarm and fault signal receiving stations.

Modifications to the system design and the products
Modifications to the system and to individual products may lead to faults, malfunctioning and safety risks. Written confirmation must be obtained from Siemens and the corresponding safety bodies for modifications or additions.
Modules and spare parts

- Components and spare parts must comply with the technical specifications defined by Siemens. Only use products specified or recommended by Siemens.
- Only use fuses with the specified fuse characteristics.
- Wrong battery types and improper battery changing lead to a risk of explosion. Only use the same battery type or an equivalent battery type recommended by Siemens.
- Batteries must be disposed of in an environmentally friendly manner. Observe national guidelines and regulations.

Disregard of the safety regulations

Before they are delivered, Siemens products are tested to ensure they function correctly when used properly. Siemens disclaims all liability for damage or injuries caused by the incorrect application of the instructions or the disregard of danger warnings contained in the documentation. This applies in particular to the following damage:

- Personal injuries or damage to property caused by improper use and incorrect application
- Personal injuries or damage to property caused by disregarding safety instructions in the documentation or on the product
- Personal injury or damage to property caused by poor maintenance or lack of maintenance

2.3 Standards and directives complied with

A list of the standards and directives complied with is available from your Siemens contact.
2.4 Release Notes

Limitations to the configuration or use of devices in a fire detection installation with a particular firmware version are possible.

⚠️ WARNING

Limited or non-existent fire detection
Personal injury and damage to property in the event of a fire.
- Read the 'Release Notes' before you plan and/or configure a fire detection installation.
- Read the 'Release Notes' before you carry out a firmware update to a fire detection installation.

⚠️ NOTICE

Incorrect planning and/or configuration
Important standards and specifications are not satisfied.
Fire detection installation is not accepted for commissioning.
Additional expense resulting from necessary new planning and/or configuration.
- Read the 'Release Notes' before you plan and/or configure a fire detection installation.
- Read the 'Release Notes' before you carry out a firmware update to a fire detection installation.

2.5 PIN guidelines

You can log into the system and enable an 'Access level' with a Personal Identification Number (PIN).
- In general, preset PINs need to be changed during or immediately after installation.
- According to the Siemens IT security requirements, every PIN must contain 8 figures.
- We do not recommend that service technicians create a PIN or change the number of figures required for a PIN to a smaller number. This must be documented.

See also
- Carrying out final commissioning work [➙ 115]
- PIN administration [➙ 94]
2.6 Cyber security disclaimer

Siemens provides a portfolio of products, solutions, systems and services that includes security functions that support the secure operation of plants, systems, machines and networks. In the field of Building Technologies, this includes building automation and control, fire safety, security management as well as physical security systems. In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art security concept. Siemens’ portfolio only forms one element of such a concept.

You are responsible for preventing unauthorized access to your plants, systems, machines and networks which should only be connected to an enterprise network or the internet if and to the extent such a connection is necessary and only when appropriate security measures (e.g. firewalls and/or network segmentation) are in place. Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For additional information, please contact your Siemens sales representative or visit https://www.siemens.com/global/en/home/company/topic-areas/future-of-manufacturing/industrial-security.html.

Siemens’ portfolio undergoes continuous development to make it more secure. Siemens strongly recommends that updates are applied as soon as they are available and that the latest versions are used. Use of versions that are no longer supported, and failure to apply the latest updates may increase your exposure to cyber threats. Siemens strongly recommends to comply with security advisories on the latest security threats, patches and other related measures, published, among others, under https://www.siemens.com/cert/en/cert-security-advisories.htm.
3 Options with requirements

You can implement the following options with requirements using the FS720 fire detection system. The sections specified below are from EN54-2/A1.

<table>
<thead>
<tr>
<th>EN54-2/A1 section</th>
<th>Options with requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.8</td>
<td>Output to fire alarm devices</td>
</tr>
<tr>
<td>7.9.1</td>
<td>Alarm confirmation input from fire alarm routing equipment</td>
</tr>
<tr>
<td>7.9.2</td>
<td>Alarm confirmation input from fire alarm routing equipment</td>
</tr>
<tr>
<td>7.10.1</td>
<td>Output type A</td>
</tr>
<tr>
<td>7.10.2</td>
<td>Output type B</td>
</tr>
<tr>
<td>7.10.3</td>
<td>Output type C</td>
</tr>
<tr>
<td>7.10.4</td>
<td>Fault monitoring of fire protection equipment</td>
</tr>
<tr>
<td>7.11.1</td>
<td>Delays to outputs</td>
</tr>
<tr>
<td>7.11.2</td>
<td>Delays to outputs</td>
</tr>
<tr>
<td>7.12.1</td>
<td>Type A dependency ¹</td>
</tr>
<tr>
<td>7.12.2</td>
<td>Type B dependency ¹</td>
</tr>
<tr>
<td>7.12.3</td>
<td>Type C dependency</td>
</tr>
<tr>
<td>7.13</td>
<td>Alarm counter</td>
</tr>
<tr>
<td>8.3</td>
<td>Fault signals from points</td>
</tr>
<tr>
<td>8.9</td>
<td>Output to fault warning routing equipment</td>
</tr>
<tr>
<td>9.5</td>
<td>Disablement of addressable points</td>
</tr>
<tr>
<td>10</td>
<td>Test condition</td>
</tr>
<tr>
<td>11</td>
<td>Standardized input/output interface ²</td>
</tr>
</tbody>
</table>

¹ For collective detector lines only
² For FT724
4 System overview

Cerberus PRO fire control panels FC721 are operated as standalone control panels. FC721 fire control panels cannot be networked with one another or with other FS720 fire control panels.

Cerberus PRO fire control panels FC721 support operation of the CNET detector line as a loop or stub. Automatic fire detectors, manual call points, I/O components, transponders and other C-NET users are connected to a C-NET detector line.

Properties
- Integrated operating unit
- Integrated line card for C-NET detector line
- Integrated power supply 70 W
- Optional power supply 70 W or 150 W in separate empty housing
# 4.1 Station types

**Overview of the fire control panel FC721 and options**

<table>
<thead>
<tr>
<th>FC721 in housing (Eco)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FC721-ZZ</strong></td>
<td><strong>FC721-YZ</strong></td>
</tr>
<tr>
<td>Standard operating unit</td>
<td>Operating unit with integrated LED indicator (24 indicator groups, each with a red/green and yellow LED)</td>
</tr>
</tbody>
</table>

1 loop or 2 stubs  
Power supply (70 W)  
Installable batteries max. 2x 7 Ah  
Housing (Eco), 430 x 398 x 103 mm (W x H x D)

### Additional empty housing

- FH2002-A1  
  - Housing (Standard)  
  - 430 x 398 x 160 mm (W x H x D)

### External printer

- DL3750+  
  - Dot matrix printer (external) to RS232 interface

### More options

- Serial RS232 module for external printer  
- Serial RS485 module  
- License key (S1) for display and operation on PC  
- Key switch (Kaba or nordic)  
- 19” mounting kit

- For additional power supply (70 W or 150 W)  
- Batteries up to 2x 25 Ah  
- RS232 module not within the scope of delivery (option)
## 5 Planning

### 5.1 FC721 system limits and options

<table>
<thead>
<tr>
<th><strong>FC721</strong></th>
<th><strong>System limits</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Detector line</strong></td>
<td></td>
</tr>
<tr>
<td>Max. C-NET addresses</td>
<td>126 <em>(1 loop or 2 stubs)</em></td>
</tr>
<tr>
<td>Number of loops or stubs</td>
<td>1 loop or 2 stubs</td>
</tr>
<tr>
<td>Number of devices per loop</td>
<td>Max. 126</td>
</tr>
<tr>
<td>Number of devices per stub line</td>
<td>Max. 32</td>
</tr>
<tr>
<td><strong>Supply</strong></td>
<td></td>
</tr>
<tr>
<td>Power supply</td>
<td>70 W</td>
</tr>
<tr>
<td>Batteries (with 70 W power unit)</td>
<td>Max. 2x 7 Ah</td>
</tr>
<tr>
<td>Battery extension (optional)</td>
<td>Max. 2x 26 Ah</td>
</tr>
<tr>
<td>External DC 24 V supply</td>
<td>–</td>
</tr>
<tr>
<td><strong>Operating unit</strong></td>
<td>Integrated</td>
</tr>
<tr>
<td><strong>Inputs and outputs</strong></td>
<td></td>
</tr>
<tr>
<td>RT alarm, relay</td>
<td>1</td>
</tr>
<tr>
<td>RT fault, relay</td>
<td>1</td>
</tr>
<tr>
<td>RT alarm monitored</td>
<td>1</td>
</tr>
<tr>
<td>RT fault monitored</td>
<td>1</td>
</tr>
<tr>
<td>Outputs for monitored, acoustic signal transmitter</td>
<td>1</td>
</tr>
<tr>
<td>Freely configurable inputs/outputs</td>
<td>4</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td></td>
</tr>
<tr>
<td>RS232/RS485 module</td>
<td>Max. 1</td>
</tr>
<tr>
<td>Ext. Printer DL3750+</td>
<td>Max. 1</td>
</tr>
<tr>
<td>LED module; 24 red/green and yellow LEDs each</td>
<td>Max. 1</td>
</tr>
<tr>
<td>EVAC-NL operating unit [NL]</td>
<td>Max. 1</td>
</tr>
<tr>
<td>License key S1</td>
<td>Max. 1</td>
</tr>
<tr>
<td>Kaba or Nordic key switch</td>
<td>Max. 1</td>
</tr>
</tbody>
</table>

* Note system limits! The description of system components and options does not form part of this technical manual.
5.2 Functions

This chapter describes the most important functions that can be supported by the fire detection system.

Decision on alarm

The danger signals of the detectors are evaluated by the zone. The decision on alarm is made at zone level. Decision on alarm can be configured as follows for each zone:

- Single-detector dependency
  - The first detector in the zone which detects the corresponding danger level, triggers a fire alarm.
- Multi-detector dependency
  - The danger levels of several detectors are included in the alarm decision (e.g. two detectors reporting danger level 3).

Alarm verification concept for delayed alarm transmission

The alarm verification concept (AVC) serves for delayed alarm transmission. The operating personnel are integrated into the alarming process. During the time (t1) for monitoring attendance, a check is run to establish whether operating personnel are present. The operating personnel can examine the fire location during the investigation time (t2) and can prevent the alerting of the fire brigade in case of false alarm.

This behavior is only applicable in operation mode 'Manned'.

In operation mode 'Unmanned', the alarm transmission is activated immediately.

Controls

Universal controls can be configured to automatically actuate the appropriate controls in the event of an alarm. Any events (e.g. alarm or isolation) are linked logically (OR, AND, NOT) to activate the controls (e.g. the closing of fire doors).

Evacuation

To ensure a controlled evacuation of people from the building in the event of fire, it is possible to configure chronological alarming in different building sections.

Remote access

The Cerberus Remote Operating Tool provides a PC-based PMI for remote access to the fire detection system. Remote access to the fire detection system is possible with the Cerberus Remote Tool. Cerberus Remote is connected to the Ethernet port of a station.
5.2.1 Defining controls

Connections for controls are available on the following components / control panels:

- Fire control panels FC721
- Input module FDCI221
- Input module FDCI222
- Input/output module FDCIO222
- Input/output module FDCIO222
- Input/output module FDCIO223
- Input/output module FDCIO224
- Addressable alarm indicator FDCAI224

The table below shows the control outputs available for the different hardware modules.

<table>
<thead>
<tr>
<th></th>
<th>FC721</th>
<th>FDCI221</th>
<th>FDCI222</th>
<th>FDCIO221</th>
<th>FDCIO223</th>
<th>FDCIO222/FDCIO224</th>
</tr>
</thead>
<tbody>
<tr>
<td>RT alarm (relay)</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Alarm output (monitored)</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>RT fault (relay)</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Alarm output (monitored)</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Monitored horn lines</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>1</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td>Monitored contact inputs</td>
<td>-</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>Non-monitored control outputs/contact inputs</td>
<td>4 freely configurable I/Os</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4 outputs</td>
</tr>
</tbody>
</table>

*Table 1: Control outputs in the fire detection system*

**Notes**

- The outputs can be used for any controls. Any events, commands and signal inputs can be linked as an OR, AND and NOT relation.
- Controls can be configured system-wide. This means that the causes can come from any point in the system.
- The controls can be configured as activated or deactivated with a delay in a range of 0...30 minutes.
- The onboard inputs/outputs in the fire control panel may be configured as inputs or outputs.
- If an onboard input/output is configured as an input in the fire control panel, it is activated by applying 0 V.
- If an onboard input/output is configured as an output in the fire control panel, it switches 0 V when active (open drain).
6 Mounting

6.1 Mounting and assembling a station

Before mounting and installation, check all the fire detection installation components visually for damage caused by improper transport.

- Components with clear signs of damage must not be used in the station or operated as fire detection installation components.
- National and local standards and requirements must be observed when assembling the station and its components.
- The following mounting instructions refer to the specifications of the EN 54 standard and the manufacturer’s recommendations.
- The site chosen to assemble the station and associated components must match the planning documents for the fire detection installation.

Figure 3: Unpacking and checking
## 6.2 Mounting instructions

The station's product insert contains an mounting model to assist with mounting. The dimensions needed and details of the mounting points are shown on the mounting model. Details on mounting and installation can be found in the reference documents.

- The station must be assembled in a dry, clean and well vented room.
- The station must be assembled at a distance of at least 1m from the room’s entrance and/or any moving parts.
- The height of mounting must be such that the display and optical indications are approx. 1.6 -1.7m above where the observer stands.
- The station and its components must be protected from dampness and interfering external influences such as dust, great temperature fluctuations and mechanical stress.
- The station must be assembled in a place freely accessible to authorized staff and the emergency services.
- The station must be fitted to a level, non-vibrating wall surface with load bearing capacity using suitable mounting materials (e.g. screws and plugs).
- The mounting surface and selected mounting must be suitable for the weight of the equipped station incl. the batteries used.
- The station may only be fitted using the 19" method if using the associated components.
- Mounting is not permitted in rooms with high levels of electromagnetic interference, e.g. in control rooms or right next to power cables and inductive loads.

### WARNING

<table>
<thead>
<tr>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electric shock</td>
</tr>
</tbody>
</table>
- Mounting and installation work may only be undertaken by qualified staff and when the system is de-energized.

### WARNING

<table>
<thead>
<tr>
<th>Thermal bridge between station and mounting surface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk of fire, for example due to the batteries overheating</td>
</tr>
</tbody>
</table>
- If the station is mounted on a flammable wall, all cut-out sections for the mounting holes must be sealed using the supplied aluminium path taps.

### NOTICE

<table>
<thead>
<tr>
<th>Electrostatics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Damage to electronics</td>
</tr>
</tbody>
</table>
- Suitable protective measures must be taken when working with electronics modules.
6.2.1 Surface-mounted assembly

- Any surface irregularities can be compensated with washers or wooden wedges.
- The rear panel is attached to the wall using screws with a diameter of 6 mm.
- The supplied edge protection strip must be placed around rectangular breakout openings.
- Depending on the cable type, up to 8 cables can be fed through each round opening (20 mm with rubber grommet).
- Only one cable may be fed through each screwed cable gland (not within the scope of delivery).

Mounting steps

1. Break out the required cable openings on the rear panel.
   Signal and control cables must be fed into the housing from above or from the rear (EMC protection).
2. Screw in the cable gland for the power cable (Ø 20 mm), or insert a rubber grommet.
3. Mark the bore holes for the dowels using the supplied drilling template. The cardboard cover in the packaging is also the drilling template. The holes in the cardboard cover correspond to the mounting holes in the rear panel. The holes can also be marked using the information in the product insert.
4. Drill the holes and insert the supplied dowels.
5. Attach the housing using the supplied screws.
6. Stick the supplied aluminium stickers over all holes for wall mounting.
7. Feed the mains cable into the housing and fix the cable with cable ties.
8. Protect the electronics if necessary using the cover of the packaging or other suitable means.
9. Regarding the mounting location of the FC721, please adhere to the instructions in this chapter.
Figure 4: Mounting of the FC721

1. Recommended display height approx. 1.6 to 1.7 m
2. Width of the FC721: 430 mm
3. Distance from door of at least one door leaf width
4. Height of the FC721:
   - 398 mm
   - Plus additional housing (Standard) = 796 mm

Assembling the FC721 and additional housing (option)
The FC721 is supplied inside the Eco housing.
An additional empty housing (Standard) can be assembled and connected for a larger battery capacity. This has space for an additional 150 W power supply and larger batteries. The additional housing is mounted directly below the FC721 and is screwed onto it.
The empty housing (Standard) consists of the following components:
   - Rear panel
   - Operator unit (empty)
   - Cover cap
Figure 5: Assembling the FC721 and additional housing (option)

1. FC721 with the 3 mounting points
2. Cable entries
3. Additional empty housing (Standard)(empty) for optional power supply (150 W)
4. Mounting points for wall mounting
5. Holes for housing assembly
6. Break-outs for cable entry
7. Break-out holes for cable entry

Mounting steps

1. Break out the required openings for feeding the cables at the bottom of the FC721 and the mounting holes for assembling the housing.
2. Break out the required openings for feeding cables and the mounting holes for housing assembly at the top on the rear panel of the extra housing.
3. Attach edge protection strips or rubber grommets at the openings for the cables.
4. Fasten the rear panel of the additional housing in the same way as for the FC721. Make sure that the alignment is exact.
5. Stick the supplied aluminium stickers over all holes for wall mounting.
6. Attach the two housings to one another by putting screws through the mounting holes in the bottom and the cover.
6.2.2 Mounting and wiring the operating unit

From IP5, the PMI & mainboard FCM2027 is used. You will find detailed information in document A6V10210368.

Figure 6: View of an FC721 with open operating unit

1. Connection (X3) for the ribbon cable on the periphery board
2. Hinge
3. Cable routing to the optional components
4. Cable ties for fixing the cables
5. Operating unit
6. Holes for securing the operating unit
7. Connection (X3) for the ribbon cable on the PMI & mainboard
8. Ribbon cable from the periphery board to the PMI & mainboard
9. Plastic clip for securing the ribbon cable
Mounting
Mounting instructions

Figure 7: Detail view of the hinge of the operating unit

1. Cut-out section on the rear panel for the hinge of the operating unit
2. Hinge of the operating unit
3. Screw for securing the hinge

Mounting steps

1. From the rear side, hang the operating unit by inserting the hinges (2) into the openings in the rear panel of the housing (1).
2. Hold the operating unit in place and secure the hinges (2) with the screws (3).
3. Insert the connection cable to the periphery board into the respective plug-in positions (1 and 5) as shown in the figure.
4. Stick the supplied cable support to the inner right side of the station at the same height as the cable and fix the flat cable.
5. Route the cables (3) of the operating unit options to the FC721 as indicated and fix these cables with cable ties (4).
6. Insert the supplied inscription strips underneath the operating unit foil as shown in the illustration.
7. Swivel the operating unit towards the FC721 and secure it using the four screws.
1. Inscription LEDs
2. Inscription standard keys 1
3. Inscription standard keys 2
4. Inscription station type

Figure 8: Inserting the inscription strips into the operating unit
6.3 LED module

The LED module installed in the FC721-YZ contains 24 groups, each with one red/green and one yellow LED. Any events can be assigned to the LEDs. Each LED may be configured as a static or flashing indicator. Normally the LED indicator is used as a zone indicator.

The LED module is only built into the FC721-YZ and is not individually available as an option.
6.4 **EVAC-NL operating unit FTO2007-N1 [NL] (FC721-HZ only)**

The EVAC-NL operating unit [NL] is an evacuation control unit for the functions required in the Netherlands. It enables the operation of a maximum number of 10 evacuation zones.

The EVAC-NL operating unit is connected to the station-internal bus.

The EVAC-NL operating unit is not individually available as an option.
6.5 Options

6.5.1 Fitting extra relay

![Figure 9: Mounting of two relays](image)

1. Fixing screws for the DIN rail
2. DIN rail
3. Relays 1 + 2
4. End clamp for the relays

**Mounting steps**

1. Insert the relays (3) on the DIN rail (2) and press them down until they latch.
2. Mount the end clamp (4) to secure the relays.
3. Depending on their intended use, connect the relays to the configurable control outputs of the periphery board. For the pin assignment, refer to the product characteristics of the respective periphery board.
### 6.5.2 Installing an RS232/RS485 module

This component is installed in exactly the same way as for the operating units with the PMI & mainboard FCM2004 and the PMI & mainboard FCM2027.

No more than one single interface module (RS232 or RS485) can be installed in an FC721.

The serial modules include:
- RS232 module (isolated), FCA2001
- RS485 module (isolated), FCA2002

These modules are mounted in the slots designed for them on the operating unit. The mounting procedure of the two serial modules is the same for all modules.

**Space and location**

![Diagram of installation location of the serial modules]

Figure 10: Installation location of the serial modules

1 RS232 module in slot X14 or 2 RS485 module in slot X19
1. Mount the cable gland (5) with the nut (4) on the flange between the fastening tabs (3).
2. Plug the serial module (1 or 6) into the corresponding connector (X14 or X19).
3. Secure the serial module to the fastening tabs (4) using the two screws (2).
4. Wire up the serial module with the intended components according to the pin assignment.

Cable glands do not have to be fitted for wiring inside the housing only.
Pin assignments
The serial modules are connected as follows:
- RS232 module: X3 DTE-HOST
- RS485 module: X2 connector

6.5.2.1 X3 DTE HOST on RS232 module

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>← DCD</td>
<td>Data Carrier Detected</td>
</tr>
<tr>
<td>7</td>
<td>← DSR</td>
<td>Data Set Ready</td>
</tr>
<tr>
<td>6</td>
<td>← CTS</td>
<td>Clear To Send</td>
</tr>
<tr>
<td>5</td>
<td>0 V</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>← RXD</td>
<td>Received Data</td>
</tr>
<tr>
<td>3</td>
<td>DTR →</td>
<td>Data Terminal Ready</td>
</tr>
<tr>
<td>2</td>
<td>TXD →</td>
<td>Transmitted Data</td>
</tr>
<tr>
<td>1</td>
<td>RTS →</td>
<td>Ready To Send</td>
</tr>
</tbody>
</table>

Admissible cable cross-section: 0.2…1.5 mm²
6.5.2.2 **X2 on RS485 module**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>RS485_A</td>
<td>Line A</td>
</tr>
<tr>
<td>3</td>
<td>RS485_B</td>
<td>Line B</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Not connected</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Not connected</td>
</tr>
</tbody>
</table>

Admissible cable cross-section: 0.2...1.5 mm²

T1  First participant  
Tn  Last participant

*) Stub lines must not exceed 20 m!  
•  Consider the polarity A, B!  
•  Terminate the line after the last participant (Tn) with 120 Ω!
6.5.3 Install shield connection terminal blocks

Figure 12: Mounting of the shield connection terminal blocks

1. Shield connection terminal block  
2. Camp bar  
3. Philips screws M 3/6

Mounting steps

1. Secure the clamp bar (2) above the rectangular cable breakout opening on the right with two screws (3)  
2. Hang the shield connection terminal blocks (1) onto the clamp bar (2) and fasten by tightening the knurled screws.
6.5.4 **Cable kit (communication)**

The cable kit (communication) FCA2014-A1 is used as an intermediate piece for wiring the external lines to the modules on the operating unit. The connecting cables supplied are fully assembled and have a length of 1110 mm. The cable kit is mounted in the top right of the housing instead of the shield connection terminal blocks.

![Figure 13: Installation of the cable kit (communication) on the rear panel (example, Standard housing)](image)

1. Screw bushings in rear panel for terminal strip
2. Terminal strip with 2 shield connection terminal blocks and connection terminals
3. 2x fixing screws
4. Periphery board

**Mounting steps**

1. First remove the shield connection terminal blocks if present.
2. Screw the mounting rail (2) to the screw bushings in the rear panel (1) using the two fixing screws (3).
3. Now wire the existing module to the operating unit using the cables provided according to the allocation plan of the respective module.
4. Guide the cable to the operating unit along the rear panel and fasten using cable ties.
6.5.5 Insert license key
The license key (S1) FCA2033-A1 is inserted in the corresponding holder on the rear of the operating unit.

![Figure 14: Using the license key on the operating unit with PMI & mainboard FCM2027](image)

![Figure 15: Using the license key on the operating unit with PMI & mainboard FCM2004](image)

1. Holder for the license key
2. License keys

**Inserting**
- Raise clamp of retainer (1) slightly and push the license key (2) underneath the clamp with the inscription pointing downward (broader, flat side to the top).

6.5.6 19" mounting kit
The 19" mounting kit FHA2016-A1 serves as a retainer for installing a station into a 19" rack or into a 19" cabinet. To fix a station, the two retainers enclosed with the kit must be mounted.
The mounting instructions described below apply to all housing types.

Figure 16: Installing the 19" mounting kit, taking the example of the Standard housing

1. Fixing screws for the station (3x or 5x), M5 x 10 pan head screws
2. Rear panel of the station
3. Fixing of the crossbars on the 19" housing or rack (2 screws each) with M5 x 10 pan head screws
4. 19" housing or rack
5. 19" cross bars (4x per kit)
6. 19" housing brackets (2x per kit)
7. Hexagonal fixing screws M6 x 12 for housing brackets (2x per side) and washers M6
8. Top 19" retainer
9. Bottom 19" retainer

1. Screw the 19" crossbars to the housing bracket. Consider the installation depth of the station.
2. Secure 19" retainers to 19" rack or in 19" cabinet. Consider the mounting height of the station.
3. Fix the station on the housing brackets.
7 Installation

The following installation instructions refer to the specifications of the EN 54 standard and the manufacturer's recommendations. The installation may only be undertaken by an electrician. Detailed instructions can be found in the system documentation.

- Use a suitable cable, e.g., NYM 3 x 1.5 mm² (max. 2.5 mm²) or a cable type with similar performance features to connect the AC voltage from the line supply.
- The line voltage fuse must be designed for a current level of 10 A.
- The mains connection cable must be routed into the control panel housing from above or from the rear.
- Provide a suitable mains separator or an appropriately labeled automatic cutout for the mains voltage connection.
- The nominal voltage required (AC 230 V or AC 115 V) is stated on the control panel type plate.
- Use a separate residual current unit for residual current circuit breakers. Depending on the installation conditions, voltage surge protection (primary protection) is required for the mains connection.

Planning and system limits

Before the installation, check whether the system's planning is suitable for the system limits. This applies e.g. to all technical data and details of cable lengths, number of line devices, number of networked stations, battery capacity and compliance with requirements from standards and national guidelines and local requirements. Details of planning can be found in the system documentation.

Information about lightning protection

Further information and detailed specifications relating to producing a lightning protection concept can be found in the relevant literature and associated standards.

⚠️ WARNING

High voltage! Danger to life!
Risk of electric shock
- Mounting and installation work may only be undertaken by qualified staff and when the system is de-energized.
- Only use cable openings or the edge protection strips provided to protect cables.

⚠️ NOTICE

Overvoltage
Damage possible
- Observe the nominal voltage required (AC 230 V) as per the control panel type plate!
- The fuses used and stated in the factory must not be bypassed or replaced with any type other than that stated.
- Take appropriate EMC protective measures when handling electronics modules.
7.1 **Protection elements**

Electro-magnetic influence and over-voltages may lead to faults in the fire detection installation. Protection elements minimize these faults.

All stations are equipped with fine protection and EMC filters in the factory. This applies to the components listed below:

- All inputs and outputs
- All lines leading away from the stations

If need be, protection elements for primary and intermediate protection must be added by the customer. These elements must be mounted at the zone limits (EMC zone), not inside the stations.

**Other possible measures by the customer**

In installations that are especially endangered by lightning, surge protectors must be installed. In case of excessive HF mains overlapping, mains filters must be installed in the feed line.

**Installation**

Twisted cables are recommended for external supply lines and lines leading to alarm devices.

7.2 **Supply concept**

The following table shows which types of energy supply are possible with the FC721.

<table>
<thead>
<tr>
<th>Use</th>
<th>FC721</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC 230 V + batteries</td>
<td>Standard</td>
</tr>
<tr>
<td>AC 230 V</td>
<td>Possible</td>
</tr>
<tr>
<td>2x DC 24 V</td>
<td>No</td>
</tr>
<tr>
<td>1x DC 24 V</td>
<td>No</td>
</tr>
</tbody>
</table>

The following chapters describe the individual energy supplies in more detail.
7.2.1 Operation with battery backup
The stations are normally operated with a power supply unit and batteries. The power supply unit feeds the hardware with galvanically isolated system voltage, simultaneously charging the batteries.
Together with the batteries, the power supply unit assumes the function of an uninterrupted power supply unit. The batteries are permanently fed via a monitored output. In case of a mains voltage failure, the batteries take over the power supply of the control panel without interruption.
The hardware is optimally protected and operational interruptions can be largely avoided.
This operation mode protects the hardware against the following:

- Voltage loss and undervoltage
- Mains overvoltage (in accordance with EN 54)
- High-energy interfering impulses (in accordance with EN 54)

Figure 17: Block diagram, power supply with battery backup

1 Electrical isolation
2 Umains / USys converter
3 Uninterrupted changeover switch
4 Batteries
5 Monitoring functions:
   - #MAINS: Mains voltage monitoring
   - #BATT: Battery monitoring
   - #CONV: Monitoring the output voltage

7.2.2 Operation without battery backup
The stations can be operated without batteries. This operation mode is used when the stations are operated via a network with external buffering, or when battery backup is omitted.

The battery monitoring function can be deactivated by means of the hardware or Cerberus-Engineering-Tool.
7.3 Position of printed circuit boards / components

Position of components in the FC721

1. Batteries
2. Power supply 70 W
3. Mains connection terminals (L1,N,PE)
4. 2 extra relays
5. Shield connection terminal blocks or cable kit (communication)
6. Periphery board (1-loop)
7. Type plate (enclosed, must be attached to the outside of the control panel housing at a clearly visible point)

Options (extract)

- 2 extra relays
7.4 Power supply - mains voltage connection

When supplied from the factory, the power supply's internal cabling is already connected.

Power supplies available

- Standard: DC 24 V / 2.5 A, power 70 W, max. battery capacity which can be connected 17 Ah (in the FC721, no more than 7 Ah due to a lack of space)
- Option: DC 24 V / 5 A, power 150 W, max. battery capacity which can be connected 45 Ah (only in additional empty housing)

![Diagram](image)

Figure 18: Mains connection

1. EMC-critical zone (no high-voltage power permitted)
2. Mains connection from below (not permitted when batteries are fitted)
3. Disconnect terminal blocks
4. Cable strain relief for mains supply line
5. Mains connection from above (recommended)
6. EMC boundary

- The network cables must be inserted from above.
- The mains lead must be placed along the left side of the housing (observe EMC zone boundary).
- Signal and control lines must only be fed into the housing on the right from above or from the rear.
- Batteries must be installed in the correct positions.
- No cable openings should be made in the base of the housing, unless an additional empty housing is mounted below the FC721 to accommodate the batteries.
- The line voltage required (AC 230 V / AC 115 V) is stated on the type plate of the FC721.
Connecting mains voltage

**WARNING**

High voltage! Danger to life!
Risk of electric shock
- Before connecting the mains voltage ensure that it is not energized and is locked to prevent it being activated.

1. Lay the mains cable (5) along the left side of the housing.
2. Insulate the power cable as appropriate and connect it to the disconnect terminal blocks (3). Use cable end sleeves for wires.
3. Fix the cable in place with the strain relief clamp (4).
4. Secure the cable with cable ties.

**Detailed diagram**

![Diagram](image)

*Figure 19: FC721 mains connection (Eco housing)*

1. Power cable (supplied from above), 3 x 1.5 mm², e.g., NYM cable type
2. Strain relief clamp
3. Ground on the rear panel
4. Disconnect terminal
5. Primary cabling for power supply
   - PE Protective conductor (terminal at the bottom)
   - N Neutral conductor (terminal in the middle)
   - L1 External conductor (terminal at the top, with mains disconnector)
Additional empty housing

If a power supply (150 W) is needed, this must be accommodated in an additional empty housing (Standard) together with the batteries.

Figure 20: Housing (Standard) for additional batteries
7.4.1 Emergency power supply
Should the AC mains voltage fail, the emergency power supply will be provided by the connected batteries with no interruptions. The emergency power bridging time depends on the control panel's quiescent and alarm current and the battery capacity used. Once the emergency power bridging time has lapsed, it must be possible for the external signal transmitters to be activated in the event of an alarm. This activation must also be ensured at a battery final voltage of DC 21.2 V.

NOTICE
Error during configuration detection
Additional effort for troubleshooting
- Only connect the battery connection cables (*) once all installation work is complete because the station will start as soon as the batteries are connected.

Figure 21: Diagram with battery wiring on 70 W power unit

Emergency power bridging time
Depending on national and local requirements, a bridging time of 72 hours or more may be needed for the emergency power supply. The battery capacity needed must be calculated and the calculation checked by measuring the power consumed during an alarm (with mains voltage deactivated). The Quantities Tool software is available for calculating the battery capacity.

New batteries / initial commissioning
When using new batteries, they must be charged for at least 24 hours before commissioning. If the date of manufacture (printed on batteries) is more than nine months ago, they will need charging for at least 48 hours.

Total discharge
There is no guarantee that totally discharged batteries can be correctly charged again. Replace batteries that have been totally discharged with new ones. You may only use the approved battery types for the emergency power supply in fire detection systems. Also note the details provided by the battery manufacturer.
7.4.2 Batteries

Calculating the battery capacity

Determine the battery capacity with the following formula:

\[ K_{\text{Batt}} = (I_{R \text{ total}} \times t_R + I_{A \text{ total}} \times t_A) \times k_{\text{dis}} \times k_{\text{age}} \]

- **K_{\text{Batt}}**: Battery capacity in [Ah]
- **I_{R \text{ total}}**: Sum of operating current of all consumers in quiescent condition [A]
- **I_{A \text{ total}}**: Sum of operating current of all consumers in alarm condition [A]
- **t_R**: Desired emergency power supply duration in quiescent condition [h]
- **t_A**: Desired emergency power supply duration in alarm condition [h] (standard 0.5 h)
- **k_{\text{dis}}**: Correction factor for discharge
  - \( k_{\text{dis}} = 1.1 \) with \( \leq 12 \)-hour emergency power supply duration. In the event of a longer emergency power supply duration, the factor can be omitted.
- **k_{\text{age}}**: Correction factor for aging
  - \( k_{\text{age}} = 1.25 \) if the desired emergency power supply duration is \( \leq 24 \) h (according to DIN VDE 0833, part 2). In all other cases, the factor can be omitted.

**Example**

\[ K_{\text{Batt}} = ((I_{R \text{ total}} \times t_R) \times k_{\text{dis}} \times k_{\text{age}}) + ((I_{A \text{ total}} \times t_A) \times k_{\text{dis}} \times k_{\text{age}}) \]

For 12 h emergency power supply duration:

\[ = ((0.9 \times 12) \times 1.1 \times 1.25) + ((3.5 \times 0.5) \times 1.1 \times 1.25) = 17.2 \text{ Ah} \]

For 24 h emergency power supply duration:

\[ = ((0.9 \times 24) \times 1.25) + ((3.5 \times 0.5) \times 1.25) = 29.2 \text{ Ah} \]

For 72 h emergency power supply duration:

\[ = (0.9 \times 72) + (3.5 \times 0.5) = 66.5 \text{ Ah} \]
Determining the battery type

Determine the battery type on the basis of the calculated battery capacity (see table).

<table>
<thead>
<tr>
<th>Designation</th>
<th>Type</th>
<th>Capacitance</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery (12 V, 7 Ah, VDS)</td>
<td>FA2003-A1</td>
<td>7 Ah</td>
<td>A5Q00019353</td>
</tr>
<tr>
<td>Battery (12 V, 12 Ah, VDS)</td>
<td>FA2004-A1</td>
<td>12 Ah</td>
<td>A5Q00019354</td>
</tr>
<tr>
<td>Battery (12 V, 17 Ah, VdS)</td>
<td>FA2005-A1</td>
<td>17 Ah</td>
<td>A5Q00019677</td>
</tr>
<tr>
<td>Battery (12 V, 25 Ah, VDS)</td>
<td>BAT12-25</td>
<td>25 Ah</td>
<td>S54302-Z102-A1</td>
</tr>
</tbody>
</table>

Table 2: Permitted batteries

NOTICE

Hardware damage
- Due to CE conformity only UL94-V2 batteries may be used.

Notes
- To achieve the system voltage of 24 V, two batteries must always be connected in series.
- Batteries are not included in the scope of supply of the stations and must be ordered separately.
- The battery capacity determines the charging current. The charging current must be taken into account when calculating the power supply.
- The dimensions of the batteries are needed to determine the housing type.

Restriction of the battery dimensions
- With greater battery capacities, the additional empty housing (Standard) should be used with a 150 W power supply.
7.4.3 Periphery board

Position of connection terminals on periphery board (1-loop) of FC721 fire control panel.

Figure 22: View of periphery board (1-loop)

X1 Connection of power unit
X3 Ribbon cable plug connection to PMI & mainboard (operating unit on pivot frame)
X6 Monitored outputs for acoustic signal transmitter, alarm and fault messages
X7 Changeover contacts for RT Alarm and RT Fault (remote transmission)
X8 Configurable inputs/outputs (1-4), supply voltage Usys 1
X11 C-NET loop 1 or stub 1+2
X400 Ribbon cable plug connection, peripheral data bus
Fxxx SMD fuses 1 A/T

More details of the periphery board (1-loop) can be found in the FS720 system documentation in the A6V10210368 product data.
7.4.3.1 Relay for fault and alarm (RT activation)

Allocation of connection terminals on periphery board (1-loop) of FC721. A cable cross-section of 0.2 to 1.5 mm² can be connected to the terminals.

<table>
<thead>
<tr>
<th>X7</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>FAU_NC</td>
<td>Break contact fault (normally closed)</td>
</tr>
<tr>
<td>5</td>
<td>FAU_COM</td>
<td>Center tap fault (common)</td>
</tr>
<tr>
<td>4</td>
<td>FAU_NO</td>
<td>Make contact fault (normally open)</td>
</tr>
<tr>
<td>3</td>
<td>AL_NC</td>
<td>Break contact alarm (normally closed)</td>
</tr>
<tr>
<td>2</td>
<td>AL_COM</td>
<td>Center tap alarm (common)</td>
</tr>
<tr>
<td>1</td>
<td>AL_NO</td>
<td>Make contact alarm (normally open)</td>
</tr>
</tbody>
</table>

The relays can be used e.g. for unmonitored activation of external devices.

Fault relay (inverse operation)

The fault relay is activated when at least one station fault has been detected. This relay is activated when the control panel is in idle mode (NC/C, inverse operation). In the event of a fault message, the relay changes the switching condition (to NO, C). Thanks to inverse operation, a fault message will still be sent in the event of the station losing all power.

Connection to an external monitoring input (example)

Connection of external control voltage e.g. for an acoustic or optical fault message (example)

Alarm relay

The alarm relay is activated when at least one station alarm message has been detected.

Example of connection with external signal transmitter, e.g. an optical normal operation/alarm message display.
### 7.4.3.2 Monitored outputs for alarm and fault (FT activation)

Connection terminals on the periphery board (1-loop) of FC721. A cable cross-section of 0.2 to 1.5 mm² can be connected to the terminals.

<table>
<thead>
<tr>
<th>X6</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>FAU_OUT</td>
<td>Output fault</td>
</tr>
<tr>
<td>5</td>
<td>VSYS_O</td>
<td>Supply output for consumer fault</td>
</tr>
<tr>
<td>4</td>
<td>AL_OUT-</td>
<td>Alarm output (-)</td>
</tr>
<tr>
<td>3</td>
<td>AL_OUT+</td>
<td>Alarm output (+)</td>
</tr>
<tr>
<td>2</td>
<td>SOUND1-</td>
<td>Output for acoustic signal transmitter (-)</td>
</tr>
<tr>
<td>1</td>
<td>SOUND1+</td>
<td>Output for acoustic signal transmitter (+)</td>
</tr>
</tbody>
</table>

The outputs can be used e.g. for monitored activation of remote transmission equipment 'RT' (e.g. phone dialing equipment). The connection lines are switched with a monitoring resistor (termination resistor). The resistance value stated corresponds to monitored normal operation. All resistance values outside this range result in a fault message.

**Enabling example for transmitting a fault message**

Terminating resistor

\[ R = 1.6 \, \text{k} \Omega \text{ - } 2.3 \, \text{k} \Omega \]

**Enabling example for transmitting an alarm message**

Monitoring resistor (\(R + R_i\))

\[ R_{\text{ges}} = 2.3 \, \text{k} \Omega \text{ - } 5.5 \, \text{k} \Omega \]
7.4.3.3 Connection of monitored acoustic signal transmitters

Connection terminals on the periphery board (1-loop) of FC721. A cable cross-section of 0.2 to 1.5 mm² can be connected to the terminals.

<table>
<thead>
<tr>
<th>X6</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>FAU_OUT</td>
<td>Output fault</td>
</tr>
<tr>
<td>5</td>
<td>VSYS_O</td>
<td>Supply output for consumer fault</td>
</tr>
<tr>
<td>4</td>
<td>AL_OUT-</td>
<td>Alarm output (-)</td>
</tr>
<tr>
<td>3</td>
<td>AL_OUT+</td>
<td>Alarm output (+)</td>
</tr>
<tr>
<td>2</td>
<td>SOUND1-</td>
<td>Output for acoustic signal transmitter (-)</td>
</tr>
<tr>
<td>1</td>
<td>SOUND1+</td>
<td>Output for acoustic signal transmitter (+)</td>
</tr>
</tbody>
</table>

Diagram showing principle

In normal operation, the connection is monitored for wire breaks and short-circuits on the connection line. A monitoring current flows through the termination resistor R (2.3 kΩ to 5.5 kΩ). All resistance values outside this range are recognized as faults. The termination resistor should be connected directly to the connection terminals of the monitored signal transmitter.

Fx ⇒ SMD fuse 1 A/T (on the periphery board)
R ⇒ terminating resistor (coverage area 2.3 kohms - 5.5 kohms)
V ⇒ blocking diode type 1N 4xxxx
M ⇒ flow of current in normal operation (monitoring)
A ⇒ flow of current during an alarm
Note total current of the station (e.g. max. 2.5 A for the 70 W power unit).
7.4.3.4 Configurable inputs/outputs

Connection terminals on periphery board of FC721 station. A cable cross-section of 0.2 to 1.5 mm² can be connected to the terminals.

<table>
<thead>
<tr>
<th>X8</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>GND_01</td>
<td>(-) supply output 1</td>
</tr>
<tr>
<td>5</td>
<td>VSYS_01</td>
<td>(+) supply output 1</td>
</tr>
<tr>
<td>4</td>
<td>I/O4</td>
<td>Configurable input/output 4</td>
</tr>
<tr>
<td>3</td>
<td>I/O3</td>
<td>Configurable input/output 3</td>
</tr>
<tr>
<td>2</td>
<td>I/O2</td>
<td>Configurable input/output 2</td>
</tr>
<tr>
<td>1</td>
<td>I/O1</td>
<td>Configurable input/output 1</td>
</tr>
</tbody>
</table>

Each of these freely configurable inputs/outputs can either be configured as an input or output. The function and external circuit needed depend on the mode of operation selected.

**Example: Principle circuit on I/O 1 (connection 1)**

**I/O 1 as 'input'**

The input can be triggered with a potential-free, external switching contact. In such cases, the corresponding input is switched to GND. Depending on the programming, a permanent or sensing contact can be connected. The activated input can be used to program one of the station's control functions.

**I/O 1 as 'output'**

Configuration as 'output' allows for the activation of external devices (e.g. relays) with 'Vsyst' voltage should certain events arise. In such cases, the corresponding output is switched to GND. The output's activation condition (e.g. alarm, fault, isolation etc.) is defined in the customer data programming.
7.5 **C-NET detector line**

Up to 126 devices, such as automatic fire detectors, manual call points, transponders, and other C-NET components, can be connected to the C-NET detector line.

The connection of the C-NET detector line is on the periphery board. Most line devices, such as fire detectors, are supplied with the operating voltage required directly by the C-NET. An external power supply is required for the FDCIO223 transponder.

---

**Figure 23: C-NET with various line devices**

**Line separator**

All C-NET devices have an integrated line separator.

In the event of a fault, e.g. a short-circuit or wire break in the C-NET wiring, the line separator is opened and the C-NET segment is shut down as soon as the fault was found. The C-NET devices remain functional and ready to detect. The fault is displayed on the station.

**Connection factor (AK, RK, MK)**

The number of connectable C-NET devices and the max. line length depend on the device connection factor. The maximum number of 126 C-NET devices and the max. length of line of 3300 m may be reduced significantly depending on the type and volume of devices.

---

**7.5.1 Connectable C-NET devices**

The table below contains a list of all devices which can be connected to the C-NET detector line. It also highlights which devices feature an ↑ alarm indicator (AI) and to which devices an ↑ external alarm indicator (ext. AI) or a sounder base (DBS 720) can be connected.

<table>
<thead>
<tr>
<th>Device type</th>
<th>Type</th>
<th>Description</th>
<th>AI</th>
<th>Ext. AI</th>
<th>DBS 720</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat detector</td>
<td>HI720</td>
<td>Heat detector for demanding applications</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Heat detector</td>
<td>HI722</td>
<td>Heat detector for standard applications</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Device type</td>
<td>Type</td>
<td>Description</td>
<td>AI</td>
<td>Ext. AI</td>
<td>DBS 720</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Flame detector</td>
<td>FDF241-9</td>
<td>Flame detector with three sensors for demanding applications with many deceptive phenomena</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Smoke detector</td>
<td>FDL241-9</td>
<td>Linear smoke detector for demanding applications with many deceptive phenomena</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>OP720</td>
<td>Optical smoke detector for standard applications with few deceptive phenomena</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Multi-sensor detector</td>
<td>OH720</td>
<td>Simple optical-thermal point detector</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>OOH740</td>
<td>Optical-thermal multi-sensor fire detector for demanding application</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>OOH740-A9-Ex&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Optical-thermal multi-sensor fire detector with CO measurement</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Aspirating smoke detector</td>
<td>FDA221</td>
<td>Aspirating smoke detector up to a monitoring area of 500 m&lt;sup&gt;2&lt;/sup&gt;</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>FDA241</td>
<td>Aspirating smoke detector up to a monitoring area of 800 m&lt;sup&gt;2&lt;/sup&gt;</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Manual call point</td>
<td>FDM221</td>
<td>Direct activation for indoor applications</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM223</td>
<td>Indirect activation (large housing)</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM223H</td>
<td>Indirect activation (large housing) for areas at risk of explosion</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM224</td>
<td>Indirect activation (large housing)</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM224H</td>
<td>Indirect activation (large housing)</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM225</td>
<td>Direct activation for indoor applications</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM226</td>
<td>Direct activation for outdoor applications</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM233</td>
<td>Indirect activation, suitable for migration from existing SIGMASYS systems to Cerberus systems</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM234</td>
<td>Direct activation, suitable for migration from existing SIGMASYS systems to Cerberus systems</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDM243H</td>
<td>Indirect activation, robust housing for use outdoors and in humid rooms, suitable for migration from existing SIGMASYS systems to Cerberus systems</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Input module</td>
<td>FDCI221</td>
<td>1 potential-free contact input</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDCI222</td>
<td>4 potential-free contact inputs</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Device type</td>
<td>Type</td>
<td>Description</td>
<td>AI</td>
<td>Ext. AI</td>
<td>DBS 720</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Zone module</td>
<td>FDCI723</td>
<td>1-zone module for connecting to collective or conventional fire detectors, with external supply. With safety barrier SB3 for areas at risk of explosion as well</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Input/output module</td>
<td>FDCIO221</td>
<td>1 potential-free contact input and 1 control output for any control</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDCIO222</td>
<td>4 potential-free contact inputs and 4 control outputs for any controls</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDCIO223</td>
<td>2 inputs/outputs can be alternatively used either for controlling sounders or connecting collective detector lines. Mixed operation, i.e. 1 input channel and 1 output channel, is also possible.</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDCIO224</td>
<td>4 potential-free contact inputs and 4 control outputs for the connection of the VdS extinguishing interface in compliance with the VdS or realization of fire controls in compliance with EN 54.</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Line separator</td>
<td>FDCL221</td>
<td>Line separator for the correct connection of several stub lines at one point on a loop</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDCL221-M</td>
<td>Multi line separator module for the correct connection of several stub lines on a loop via a line separator</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Ex loop separators</td>
<td>FDCL221-Ex</td>
<td>Line separator for the correct connection of a stub line at one point on a loop in an area at risk of explosion</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Alarm sounder</td>
<td>FDS221</td>
<td>Acoustic alarm device with various tones and sound levels</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>FDS229</td>
<td>Acoustic alarm sounder with supplementary optical indication with various tones and sound levels and beacon</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Sounder base</td>
<td>DBS720</td>
<td>Detector base with integrated alarm device</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Interbase</td>
<td>DBS721</td>
<td>Sounder interbase with integrated acoustic alarm device</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>DBS728</td>
<td>Interbase with integrated alarm device, acoustic and optical</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>DBS729</td>
<td>Interbase with integrated alarm device, acoustic and optical</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Detector base</td>
<td>DB721</td>
<td>Detector base with loop contact</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Floor repeater terminal</td>
<td>FT2010</td>
<td>For the system-wide indication and operation of the most important information and functions</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Floor repeater display</td>
<td>FT2011</td>
<td>For the system-wide indication of the most important information</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### Table 3: Devices which can be connected to the C-NET detector line

<table>
<thead>
<tr>
<th>Device type</th>
<th>Type</th>
<th>Description</th>
<th>AI</th>
<th>Ext. AI</th>
<th>DBS 720</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mimic display indication</td>
<td>FT2001</td>
<td>For the system-wide indication of events</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>External alarm indicator</td>
<td>DJ 119x</td>
<td>For optical indication in the event of alarm</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>External alarm indicator</td>
<td>FDCAI221</td>
<td>Addressable alarm indicator that can be assigned to any cause using a control</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Radio gateway</td>
<td>FDCW221</td>
<td>For the wireless transmission of detector signals to the C-NET</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Radio smoke detector</td>
<td>DOW1171</td>
<td>Smoke detector for the wireless transmission to the radio gateway FDCW221</td>
<td>X</td>
<td>--</td>
<td>-</td>
</tr>
<tr>
<td>Manual call point with radio base</td>
<td>SMF6120 SMF121</td>
<td>Manual call point for the wireless transmission to the radio gateway FDCW221</td>
<td>--</td>
<td>--</td>
<td>-</td>
</tr>
<tr>
<td>SWING radio gateway</td>
<td>FDCW241</td>
<td>Gateway for the wireless transmission of detector signals to the C-NET</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Neural radio fire detector (SWING)</td>
<td>FDOOT271</td>
<td>Optical-thermal fire detector with radio transmission to the radio gateway FDCW241</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Radio manual call point (SWING)</td>
<td>FDM273</td>
<td>Indirect activation via radio gateway FDCW241</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Aspirating smoke detector</td>
<td>VLF VESDA LaserFocus (laser monitoring)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### Notice

**Influencing the earth fault monitoring**

Faults
- For devices on the C-NET with a separate supply, the supply must be electrically isolated. FDCIO223 is an exception to this rule.

The number of connectable devices depends on the specific AK, RK, MK connection factor of the type and is calculated using the 'Quantities Tool' software. Note the specifications of the individual C-NET devices in the 'List of Compatibility' document, see 'Applicable documents' chapter.
7.5.2 Connectable 'voice sounder beacon/voice sound. beacon base' devices

In addition to fire detectors, other devices can be operated on the ↑ C-NET detector line; these devices communicate via the C-NET protocol.

The table of connectable Voice alarm sounder beacon/Voice al. sound. beacon base below applies to all fire control panels from MP7 with installed ↑ line cards and to the optional line card (FDnet/C-NET) FCL2001-A1 in fire control panels with card cages.

You will find information about the country-specific availability of devices in document ‘Delivery Release’.

The following table lists all ‘Voice alarm sounder beacon/Voice al. sound. beacon base’ devices that can be connected to the C-NET detector line.

<table>
<thead>
<tr>
<th>Device type</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm sounder</td>
<td>FDS224-R</td>
<td>Sounder, red housing</td>
</tr>
<tr>
<td></td>
<td>FDS224-W</td>
<td>Sounder, white housing</td>
</tr>
<tr>
<td>Alarm sounder with supplementary</td>
<td>FDS226-RW</td>
<td>Sounder beacon, red housing, white LED</td>
</tr>
<tr>
<td>optical indication</td>
<td>FDS226-WW</td>
<td>Sounder beacon, white housing, white LED</td>
</tr>
<tr>
<td></td>
<td>FDS226-RR</td>
<td>Sounder beacon, red housing, red LED</td>
</tr>
<tr>
<td></td>
<td>FDS226-WR</td>
<td>Sounder beacon, white housing, red LED</td>
</tr>
<tr>
<td>Voice alarm device</td>
<td>FDS225-R</td>
<td>Voice sounder, red housing</td>
</tr>
<tr>
<td></td>
<td>FDS225-W</td>
<td>Voice sounder, white housing</td>
</tr>
<tr>
<td>Voice alarm sounder with</td>
<td>FDS227-RW</td>
<td>Voice sounder, red housing, white LED</td>
</tr>
<tr>
<td>supplementary optical indication</td>
<td>FDS227- WW</td>
<td>Voice sounder, white housing, white LED</td>
</tr>
<tr>
<td></td>
<td>FDS227-RR</td>
<td>Voice sounder, red housing, red LED</td>
</tr>
<tr>
<td></td>
<td>FDS227-WR</td>
<td>Voice sounder, red housing, red LED</td>
</tr>
<tr>
<td></td>
<td>FDS227-RW-C</td>
<td>Voice sounder, red housing, white LED, voice-configured</td>
</tr>
<tr>
<td></td>
<td>FDS227-WW-C</td>
<td>Voice sounder, white housing, white LED, voice-configured</td>
</tr>
<tr>
<td></td>
<td>FDS227-RR-C</td>
<td>Voice sounder, red housing, red LED, voice-configured</td>
</tr>
<tr>
<td></td>
<td>FDS227-WR-C</td>
<td>Voice sounder, red housing, red LED, voice-configured</td>
</tr>
<tr>
<td>Sounder base with supplementary</td>
<td>FDSB226-WW</td>
<td>Sounder beacon base, white housing, white LED</td>
</tr>
<tr>
<td>optical indication</td>
<td>FDSB226-WR</td>
<td>Sounder beacon base, white housing, red LED</td>
</tr>
<tr>
<td>Voice sounder base with</td>
<td>FDSB227-WW</td>
<td>Voice sound. beacon base, white housing, white LED</td>
</tr>
<tr>
<td>supplementary optical indication</td>
<td>FDSB227- WR</td>
<td>Voice sound. beacon base, white housing, red LED</td>
</tr>
<tr>
<td></td>
<td>FDSB227- WW-C</td>
<td>Voice sound. beacon base, white housing, white LED, voice-configured</td>
</tr>
<tr>
<td></td>
<td>FDSB227-WR-C</td>
<td>Voice sound. beacon base, white housing, red LED, voice-configured</td>
</tr>
</tbody>
</table>

*Table 4: ‘Voice alarm sounder beacon/Voice al. sound. beacon base’ devices that can be connected to the C-NET detector line*

The ‘Voice alarm sounder beacon/Voice al. sound. beacon base’ devices are supplied via the ↑ detector line.

All ↑ C-NET devices have an integrated line separator.
Additional documentation
- You will find detailed information on functions, connection factors, and device compatibility in document 'List of compatibility'.
See chapter 'Applicable documents'.

7.5.3 C-NET topology and connection

Permissible topology for the C-NET
The C-NET can be wired in the topology shown below. Regardless of the topology (loop, stub or loop with sub-stub), the C-NET system limits, such as length, cable resistor, number of users etc., must be observed.
Either one loop or two stubs can be connected to the C-NET detector line of the FC721 (2-wire line to block of 4 terminals).

Loop
(max. 1 loop)

Stub
(max. two stubs)

Sub-stubs on loop
A sub-stub must only be connected between two line devices or line separators as well as directly to the terminal connection.

Wiring NOT admissible

NOT admissible!
Sub-stub on sub-stub

NOT admissible!
Sub-stub on a stub
The connection terminals for the C-NET are on the periphery board.

**Figure 24: Position of C-NET connection terminal on the periphery board**

- Max. 126 C-NET devices are permitted on the C-NET connection (block of 4 terminals).
- The C-NET devices can be distributed on the loop (max. 126 devices) or on two stubs (max. 32 devices per stub).

**Loop connection example**
- Max. 126 line devices

![Loop connection example diagram](image)

**Figure 25: C-NET loop circuit**

Alternatively, the connection of two stubs instead of one loop is possible

**Stub connection example**
- Max. 32 line devices per stub
- Total of max. 64 line devices per line connection (4 terminals)

![Stub connection example diagram](image)

**Figure 26: C-NET stub circuit**
Cable types
As a result of national standards and requirements, installation may require a particular cable type. Note the respective requirements and planning documents. The following cable types can always be used for cabling the detector line:
- Twisted, with and without shielding (recommended)
- Untwisted, with and without shielding

Cable shielding
When using shielded lines (e.g. fire detection cable J-Y(St)Y n x 2 x 0.8 mm), ensure that the cable shielding is only connected on one side.
The fire control panel's function may be impaired by a missing or incorrect cable shielding connection. The ‘Shield connection terminal blocks’ option is available for the connection. Depending on the installation environment and requirements of relevant standards, cable shielding may have to be connected and merged at one central connection point.
7.5.4 **Wiring principle behind C-NET devices**

The screw terminals for directly connecting the C-NET cable are integrated in every C-NET line device. The connection terminals with input (+/-) and output (+/-) are the same for all users, with the exception of the detector base.

![Diagram showing wiring example of C-NET detector devices on loop](image)

- Connection terminal
- Detector base and sounder base
  - 1b (corresponds to +, input/output)
  - 5 (corresponds to input)
  - 6 (corresponds to output)
- Manual call point
- Input/output modules
- Transponder
- Alarm sounder with beacon

*Figure 27: Wiring example of C-NET detector devices on stub*

1. If shielded connection cables are used, the cable shielding must be connected on one side.
2. The number of connectable C-NET devices and the max. line length depend on the device connection factor. The maximum number of 126 C-NET devices per loop and the max. length of line of 3300 m may be reduced significantly depending on the type and volume of line devices. (Calculation must be performed using 'Quantity Tool' software).
8 Structure and function

8.1 Indication and operating elements

<table>
<thead>
<tr>
<th>Indication</th>
<th>Fire control panel FC721</th>
<th>LED module FTO2008</th>
<th>Floor repeater terminal FT2010</th>
<th>Floor repeater display FT2011</th>
<th>Cerberus Remote</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Pre-alarm</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Fault</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Isolation</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Test mode</td>
<td>X</td>
<td>X</td>
<td>--</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Technology</td>
<td>X</td>
<td>X</td>
<td>--</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Activation</td>
<td>X</td>
<td>X</td>
<td>--</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Information (Note)</td>
<td>X</td>
<td>X</td>
<td>--</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Activated remote transmission (RT)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>--</td>
<td>X</td>
</tr>
</tbody>
</table>

**Operation**

| Acknowledge                  | X                        | --                  | X                              | --                             | X               |
| Reset                        | X                        | --                  | X                              | --                             | X               |
| Scroll in event lists        | X                        | --                  | X                              | X                              | X               |
| Deactivate internal buzzer   | X                        | --                  | X                              | X                              | X               |
| Deactivate sounder           | X                        | --                  | --                             | --                             | X               |

*Table 5: Functions of the individual operation and indication devices*

- **X**: Possible / available
- **-**: Not possible / not available
The FC 721 has an integrated operation and indicator field which can be used to operate, maintain and (with limitations) configure the station.

Figure 28: Operation and indicator field front of Cerberus fire control panel

1 Display, illuminated with plain text display
2 Cursor keypad for navigation/selection of menu items
3 Menu button
4 Keypad (for direct selections by entering numbers and/or entering and changing objects-specific display texts)
5 C button (Cancel) and OK button (confirmation of selection)
6 Menu-dependent function keys (softkeys)
8.2 Extra indication and operating devices

The FT2010 floor repeater terminal and FT2011 floor repeater display allow for the decentralized indication of the most important events in the fire detection system and limited operation. Both devices can be connected to the C-NET directly as bus users. They can be powered via the C-NET or by an external power unit. If supplied externally, the source of voltage requires electrical isolation.

Floor repeater terminal FT2010

The following indications and operations are possible on the floor repeater terminal:

**Indication**
- Alarm and fault messages of connected station(s)
- Activated remote transmission (RT)

**Operation**
- Acknowledge (start investigation time)
- Reset
- Scroll in event lists
- Deactivate buzzer
- Four freely programmable keys

Floor repeater display FT2011

The following indications and operations are possible on the floor repeater display:

**Indication**
- Alarm and fault messages of connected station(s)

**Operation**
- Scroll in event lists
- Deactivate buzzer

Guideline
- External power supply is possible with DC 24 V or AC 24 V.
- Floor repeater terminals and floor repeater displays that are not fed by the detector line (separate power supply) must be electrically isolated from the system voltage.

**NOTICE**

Influencing the earth fault monitoring

**Faults**
- Electrical isolation of the supply unit must be available for devices on the C-NET that are fed separately. If there is no electrical isolation, the earth fault monitoring on the C-NET is affected which may result in faults.

- When an external supply unit is used, it must be taken into account that should the external supply unit fail, the maximum current connection factor increases significantly (line failure is possible).
- When power supply is ensured via the detector line, the high maximum current connection factor must be taken into account.
- At total of up to 8 floor repeater terminals and floor repeater displays can be connected to fire control panel FC721.
8.2.1 **Mimic display driver FT2001**
The mimic display driver is a parallel LED indication for the system-wide signaling of events and is connected to the C-NET detector line. The LED are built in a ground plan panel.

8.3 **Connecting external alarm indicators**
Some C-NET devices have an output where normally an external alarm indicator is connected. The output can, however, also be used for any other controls. The output for the external alarm indicator is controlled by the fire control panel and is freely configurable. Depending on the configuration, the output is activated for the external alarm indicator if the following is true:
- The connected detector is in danger level 2 or 3 (together with the internal alarm indicator).
- The assigned zone has triggered an alarm or pre-alarm.
- The assigned control is active.

The following external alarm indicators are available:
- DJ119xFDAI9x – external alarm indicators that must be connected to the detector to be displayed.
- FDCAI221 – addressable alarm indicator that can be assigned to any cause using a control.

![Figure 29: Examples of an external alarm indicator](image)

1 External AI configured in parallel to the zone
2 External AI configured in parallel to the internal AI of the connected detector (e.g. false ceiling)
3 External AI configured in parallel to any other zone (via control)
8.4 **Software**

The following software is available for planning, configuration and commissioning:

**FXS7212 Cerberus Engineering Tool**
For programming the object- and customer-specific control panel functions.

**FX7220 Cerberus Remote**
Indicates a graphic representation of a station's PMI, provided that the PC is connected to the station.

Cerberus-Remote is software for the PC which can be used to display the Person Machine Interface of a 'Station' on the PC, if the corresponding approval is granted. Depending on the operation mode, Cerberus-Remote can either be used for display purposes or for display and operation purposes.

**Quantities Tool**
The outline quantities tool can be used to calculate C-NET utilization (AK, RK, MK connection factors) and determine the C-NET line card load.

This results in e.g.:
- Number and type of devices per detector line
- Number of required line cards
- Number of C-NET loops and stubs
- Battery capacity required (emergency power supply)

Detailed information on configuration of the fire detection installation and working with the software tools can be found in the reference documents stated.
9 Operation functions

The following chapters contain descriptions of important functions for directly operating the site.
You will find information on the system functions in the corresponding chapter.

9.1 Selection and opening / execution

After calling up the main menu and any other list, the first entry in the list is selected. The selection is indicated by a rectangular frame around the entry.
The opening of a list item or the execution of a list command is performed by moving the cursor to the selected entry and pressing <ok>.

Other methods to open or execute a highlighted list entry are given by pressing the following buttons:
- <►>
- <Number> on the numerical block (given number in brackets – only in selection lists)

Changing the selection

The selection indicated is changed as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Consequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;►&gt;</td>
<td>Next entry</td>
</tr>
<tr>
<td>&lt;◄&gt;</td>
<td>Previous entry</td>
</tr>
<tr>
<td>&lt;More alarms&gt;</td>
<td>Opens alarm list / jumps to the next entry in the alarm list shown</td>
</tr>
<tr>
<td>&lt;Number&gt; + &lt;ok&gt;</td>
<td>Goes to the entry with the number entered – not in selection lists</td>
</tr>
<tr>
<td>↑ 'More Options' + 'Jump to begin' softkeys</td>
<td>J ump to the top of the list</td>
</tr>
<tr>
<td>More Options' + 'Jump to end' softkeys</td>
<td>J ump to the end of the list</td>
</tr>
</tbody>
</table>

9.2 Scrolling

You can use the navigation keys to scroll through a displayed list in the display.

You can scroll to the start/end of the lists (limited function) and back in the following lists:
- Option lists
- Command lists
- Element category lists

In all other lists, you can scroll beyond the end of the list to the start of the list and back.
9.3 Indication of the position and length of the list

There is a vertical bar along the side of a list when the list is longer than can be indicated on the display.

The black part of the bar shows the position and size of the part of the list you can see in relation to the entire list.

Examples for the representation in different lists:

1 Bar in normal view with list

<table>
<thead>
<tr>
<th>06-05-22 02:25:36</th>
<th>GGGGGG 21</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-05-23 09:25:36</td>
<td>GGGGGG 22</td>
</tr>
<tr>
<td></td>
<td>VVVVV</td>
</tr>
</tbody>
</table>

2 Bar in window with list

<table>
<thead>
<tr>
<th>ZZZ</th>
<th>ZZZ</th>
<th>ZZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABD</td>
<td>ABD</td>
<td>ABD</td>
</tr>
<tr>
<td>EFGH</td>
<td>EFGH</td>
<td>EFGH</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9.4 Shortcut

A shortcut serves for the direct execution of an entry in a selection list by pressing a numeric key.

In a command list, for example, you can execute a command directly by entering the corresponding number.

The numbers for the shortcut are shown in the list entry line, on the right and in brackets.

9.5 Favorites

The favorites are represented in the display of the ↑ Person Machine Interface.

The first three favorites are assigned to the three ↑ softkeys in the main menu. All favorites are listed in the 'Favorites' menu. To execute a favorite function, you must press the corresponding key on the keypad.

There are a maximum of eight favorites of which three are preconfigured. Each favorite can be assigned a function. With that you can quickly carry out often used actions and commands.

You will find information on assigning favorites in the configuration document. See chapter 'Applicable documents'.
9.6 Entry of numbers and letters
You can use the keyboard to enter numbers and letters in input dialogs.

**Numeric entry**
- The number of underscores corresponds to the number of possible positions for the entry.
- The overwrite mode is set by default; there is no insert mode.
- Horizontal navigation within the input field is possible with the keys \(<\) and \(\text{\textasciitilde}>\).
- Use \(\text{\textasciitilde}>\) to delete the character to the left of the cursor position.
- Use \(<\text{ok}>\) to save the entered value and exit the input field.
  - When there are several input fields in the window, the cursor jumps to the next field by pressing \(<\text{ok}>\).
  - If the cursor position is in the last or only input field, close the input dialog by pressing \(<\text{ok}>\).
- Use \(<\text{C}>\) to cancel the input and close the dialog without saving.

**Alphanumeric entry**
- Alphanumeric entries are only possible in particular input fields, e.g. for customer text.
- Letters are entered in the same way as letters on telephones. You can select the corresponding letter by pressing a key several times.
- Switching between lower and upper case letters is possible with the key \(\text{\textasciitilde}>\) and only applies for the next character.

In input fields with more than one line, you cannot change back to a line above the cursor position.
10 Connectivity and communication with 'Station'

A PC does not have to be directly connected to a 'Station' to be able to communicate with a 'Station' in the 'Site'. The PC can be connected to any place in the Ethernet.

Detailed information about the connection variants can be found in the 'Establishing connection from PC to FS720 network' chapter in document A6V10210424. See chapter 'Applicable documents'.

10.1 Setting Windows firewall

- The Windows firewall may prevent the PC connecting to the 'Station'.
- A functioning Ethernet connection between the Cerberus-Engineering-Tool on the PC and the FS720 control panels is required to update the firmware, for example.

Setting Windows firewall

- Create a firewall rule for Windows. To do this, proceed as follows:

You must have administrator rights to make the following settings.

10.1.1 Windows XP

您有管理员权限的PC

1. Open the Windows start menu.
2. Select 'Settings' > 'Control panel' > 'Administrative Tools' > 'Services'.
3. Right-click on 'Windows Firewall/Internet Connection Sharing (ICS)' in the new window.
4. Select 'All Tasks' > 'Exit' in the context menu.
5. Once the work is complete, reactivate the firewall. To do this, proceed as described above but select 'All Tasks' > 'Start' in the context menu.

NOTICE

Security vulnerability in operating system due to deactivated firewall
Unauthorized access to your PC
- Activate the firewall after the firmware update.
## 10.1.2 Windows 7 / Windows 8 / Windows 10

There are different ways of setting up firewall rules in Windows 7/8/10. The following settings apply for Siemens PCs which use group guidelines controlled by the domain.

### NOTICE

The following settings must be made under Local Security Policy.

- Open **Local Security Policy** to configure Windows Firewall with Advanced Security.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have administrator rights on your PC.</td>
</tr>
<tr>
<td>The PC is connected to the Siemens intranet.</td>
</tr>
</tbody>
</table>

1. Open the Control Panel.
   - E.g., via the Windows Start menu in Windows 7.
   - E.g., in Windows 10: Right-click on the Windows symbol at the bottom left and select Control Panel in the context menu.

2. **NOTICE!** The following settings must be made under Local Security Policy.
   Select 'Control Panel' > 'All Control Panel Items' > 'Administrative Tools' > 'Local Security Policy' > 'Windows Firewall with Advanced Security'.

3. Expand the subtree of the menu.

4. Right-click 'Inbound Rules' > 'New Rules'.
   - This opens the 'New Inbound Rule Wizard'.

5. Select 'Rule Type' and activate 'Program'.

6. Click 'Next >' to confirm and enter the program path to 'F-FXS7212.exe'.
   - Example: C:\Program Files (x86)\Siemens\F-FX7230\XS_en_1-V5.0
   - **NOTICE!** Remember to enter/add the new path if the version changes.

7. Click 'Next >' to confirm and then confirm the default setting 'Allow the connection' in the next step ('Action').

8. In the next step 'Profile', remove the check mark from the 'Domain' checkbox.
   - The 'Private' and 'Public' checkboxes are checked.

9. Click 'Next >' to confirm and enter an appropriate name in the next step ('Name'), such as 'FS720 application'.

10. Click 'Finish' to complete the process.
    - A 'New Rule' has now been set and appears in the 'Inbound Rules' list.

It is necessary to make additional settings for the new rule:

1. Right-click the new rule and select 'Properties'.
2. Select the 'General' tab in the 'Rule Name Properties' window.
3. Set the following values:
   - 'General': 'Activated'
   - 'Action': 'Allow connection'
4. Select the 'Protocol and Ports' tab.
5. Set the following values:
   - 'Protocol type': 'UDP'
   - 'Local port': 'Specific Ports', and enter the value range '50067-50070' in the box.
   - 'Remote port': 'All Ports'
6. Confirm with 'OK'.

   ✦ The new firewall rule is now configured.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security vulnerability in operating system due to open ports</strong></td>
</tr>
<tr>
<td>Unauthorized access to your PC</td>
</tr>
<tr>
<td>• Deactivate the firewall rule configured above after the firmware update.</td>
</tr>
</tbody>
</table>

10.2 **Connecting the PC to the station**

   For most commissioning, maintenance and repair work a PC with installed Cerberus-Engineering-Tool is required. The figure below shows the connection between the PC and 'Station'.

   ![Figure 30: Rear panel of operating unit and PC](image)

   **LAN** Ethernet connection
   1 Required cable type: CAT 5, CAT 6, or CAT 7
10.3 Disconnecting the PC from the station

As the IP address is bound to the MAC address while there is a connection between the PC and the 'Station' and as it remains in the cache even in the case of a short break in the connection of ≤2 min., you must observe the following instructions.

**NOTICE**

Incorrect disconnection of 'Station'
Establishing a connection to other 'Station' is not possible
- Disconnect the PC from the 'Station' as described in the following instructions.

The connection between the PC and the 'Station' must be disconnected as follows:
2. Disconnect the cable connection between PC and 'Station'.
3. Wait ≥2 min. before you establish a connection to another 'Station'.

10.4 Loading data to the 'Station'

Data is loaded from Cerberus-Engineering-Tool to the 'Station' when the following commands are performed.
- 'Initialize station'
- 'Download site'

If you use a number of network cards on the PC, observe the information in the chapter 'IP settings for several network cards' in document A6V10210424. See chapter 'Applicable documents'.

The table below shows which data is overwritten in the 'Station'.

<table>
<thead>
<tr>
<th>Command</th>
<th>Overwrites the ↑ BDV</th>
<th>Sets the address of the 'Station'</th>
<th>Overwrites the configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Initialize station'</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>'Download site'</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

1 Command is only performed for the 'Station' that is connected to the PC via LAN.
2 The configuration of selected 'Stations' or all 'Stations' in the ↑ 'Site' can be overwritten as an option.

See also
- Loading configuration from the PC to the station [➔ 82]
- Initializing 'Station' [➔ 80]
10.5 Initializing 'Station'

- Each 'Station' in a system with several networked 'Stations' must have a unique address.
- Once a 'Station' has been started for the first time or once the firmware on the main CPU has been updated, a 'Station' has the address '1'. Networked 'Stations' must therefore all be initialized.
- If two 'Sites' are merged to form one 'Site', the 'Stations' with the same addresses in the added 'Site' must each be given a new address.
- The 'Initialize station' procedure issues the 'Station' an address within the 'Site' according to the configuration in Cerberus-Engineering-Tool.

A standalone 'Station' does not have to be initialized.

If you use a number of network cards on the PC, observe the information in the chapter 'IP settings for several network cards' in document A6V10210424. See chapter 'Applicable documents'.

Initialize 'Station'

### NOTICE

**Connection module (card cage) FCA2006-A1 defective or installed incorrectly**

Control panels identified incorrectly, e.g. FC726 identified as FC724.

- Check that the connection module (card cage) FCA2006-A1 is installed correctly.

### NOTICE

**Faulty initialization for networked station**

During initialization, the station must not be connected to the network or any other station.

- The PC is connected locally to the 'Station'.
- Highlight the 'Station' you want to initialize.
- Select the 'Commissioning' > 'Initialize station' menu item.
  - The following window is opened:

  ![Initialize station window](image)

- Click on 'Start'.
  - The 'Set the station to access level 3' window opens.
- Press <MENU> on the 'Station' and enter a valid PIN.
5. Click on 'OK' in the 'Set access level' window.
   ⇨ The 'Station' is initialized.
   ⇨ The 'Station' is restarted.
   ⇨ After a few minutes, the 'Buzzer' sounds twice.

6. Press <Acknowledgement> on the ↑ Person Machine Interface to switch off the 'Buzzer'. Do not perform any more actions on the 'Station' until the 'Buzzer' has sounded for the second time.
10.6 Loading configuration from the PC to the station

You can use the 'Download site' function to load the configuration of one 'Site' from the Cerberus-Engineering-Tool on the PC into the 'Station'.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Different network configuration in 'Cerberus-Engineering-Tool' and networked 'Site'</strong></td>
</tr>
<tr>
<td>When the selection displayed for 'Download site' is manually modified, in special cases it may be necessary to reset a 'Station' to the factory setting as well as a 'Initialize station'.</td>
</tr>
<tr>
<td>● Do not modify the selection displayed for 'Download site' in normal cases.</td>
</tr>
<tr>
<td>● Check the sequence when loading different configuration states in special cases.</td>
</tr>
<tr>
<td>● After any change of the network configuration, make sure that all 'Stations' in the 'Site' for the 'Download site' procedure are selected and can be accessed.</td>
</tr>
<tr>
<td>● Temporarily update non-accessible 'Stations' to the latest status of the global network configuration prior to integration in the network.</td>
</tr>
</tbody>
</table>

1 Examples of special cases:

- A 'Station' will be added to a networked 'Site' and a new network configuration will be loaded upon initialization of this 'Station', different from the global network configuration of the connected 'Site'.
- During the 'Download site' procedure a 'Station' is temporarily not accessible. Both examples can result in the 'Station' no longer starting after the 'Download site' procedure and the above actions having to be carried out.

If you use a number of network cards on the PC, observe the information in the chapter 'IP settings for several network cards' in document A6V10210424. See chapter 'Applicable documents'.
WARNING

Activation of fire or smoke dampers
If fire or smoke dampers are connected to the FS720 via an input/output module, they may be activated when the station is switched off or when the station or detector line is restarted.

- If necessary, block the outputs temporarily [→ 110] before switching off the station or restarting the station/detector line.

The ‘Site’ is opened in Cerberus-Engineering-Tool.
The PC is connected to the 'Station'.
Networked 'Stations' are initialized.
'Station' and Cerberus-Engineering-Tool have the same 'Site' ID.
'Station' and Cerberus-Engineering-Tool are part of the same sales channel.

1. Select 'Commissioning' > 'Download site' in Cerberus-Engineering-Tool.

- The 'Download site' and 'Connect' windows open in Cerberus-Engineering-Tool.

2. Select the connection in the 'Connect' window and click on 'OK'.

- The 'Stations' are listed in the 'Download site' window.

3. Select the 'Stations' whose configuration you would like to load from 'Cerberus-Engineering-Tool' to the 'Stations' and click on 'Start'.

- The 'Set access level' window may open in Cerberus-Engineering-Tool with the 'Set the station to access level 3' prompt. Press <MENU> on the 'Station', enter the PIN and press <ok>.

4. Click on 'OK' in the 'Set access level' window in Cerberus-Engineering-Tool.

- The 'Action confirmation' window opens in Cerberus-Engineering-Tool.

5. Click on 'Yes'.

- The configuration is loaded to the 'Station'.
- The progress is displayed in the 'Download site' window in Cerberus-Engineering-Tool.
- The 'Station' restarts.
- After a few minutes, the 'Buzzer' sounds twice at the 'Station'.

6. Press <Acknowledge> on the ↑ Person Machine Interface at the 'Station' to switch off the 'Buzzer'. Do not perform any more actions on the 'Station' until the 'Buzzer' has sounded for the second time.
10.7 Loading configuration from the station to the PC

The 'Upload site' function can be used to load the configuration of a 'Site' to Cerberus-Engineering-Tool on the PC.

- The 'Site' is opened in Cerberus-Engineering-Tool.
- The PC is connected to the 'Station'.
- 'Station' and Cerberus-Engineering-Tool have the same 'Site' ID.
- 'Station' and Cerberus-Engineering-Tool are part of the same sales channel.

1. Select 'Commissioning' > 'Upload site'.
   - The 'Upload site' and 'Connect' windows are opened.

2. Select the connection in the 'Connect' window and click on 'OK'.
   - The 'Stations' are listed in the 'Upload site' window.

3. Select the 'Stations' whose configuration you would like to load to Cerberus-Engineering-Tool and click on 'Start'.
   - The 'Action confirmation' window opens.

4. Click on 'Yes'.
   - The configuration is loaded to the PC.
   - The progress is displayed in the 'Upload site' window.

10.8 Creating a backup of the 'Site' configuration

With the 'Create backup embedded configuration' function, you can create a backup file of the 'Site' configuration.

The following conditions must be satisfied for a complete backup:
- All of the 'Stations' in the 'Site' must be networked and commissioned.
- The 'Site' IDs for all 'Stations' must match the 'Site' ID for the 'Site' loaded in Cerberus-Engineering-Tool.
- The BDVs for all 'Stations' must be compatible with the BDV for the 'Site' loaded in Cerberus-Engineering-Tool.
  - The BDVs are compatible when the major version and the minor version are identical. The bugfix version is not relevant for the compatibility. The versions are saved in the BDV file name. You will find more information on the format of the BDV file name in document A6V10210424.
  - The country codes of the BDVs for all 'Stations' must match the BDV for the 'Site' loaded in Cerberus-Engineering-Tool.

You will find information about BDV names and versions in document A6V10210424. See chapter 'Applicable documents'.

If the above-mentioned conditions are not satisfied, a corresponding message is displayed and an incomplete backup file created. In this instance, 'incomplete' is added to the file name of the backup file.
Creating a backup

- The 'Site' is opened in Cerberus-Engineering-Tool.
- The PC is connected to a 'Station'.

1. Select 'Commissioning' > 'Create backup embedded configuration'.
   - The 'Create backup embedded configuration' and 'Connect' windows are opened.

2. Select the connection in the 'Connect' window and click on 'OK'.
   - The 'Site' configuration is loaded to the PC and saved as a backup file.
   - The progress is displayed in the 'Create backup embedded configuration' window.

Backup file

- The backup file is saved in the following directory as standard:
  C:\ProgramData\Siemens\FX7230\[Softwareversion]\Sites\embeddedBackups
- The backup file has the following name:
  <'Site' name>_<>(backup counter>_<incomplete>.fsc
  Example: Test_Site_007_incomplete.fsc
  - 'Site' name: Name of the 'Site'.
  - Backup counter: Three-digit number that is automatically assigned to each backup.
  - 'incomplete': If it was not possible to create a complete backup, 'incomplete' is added to the file name.
- A maximum of ten 'Site' backup files are saved. If more than ten backup files are created, the oldest file is automatically overwritten with the new one.

In the pre-settings, you can define that a backup file is created automatically each time a configuration is loaded from the PC to the 'Station' using the 'Download site' command. To do this, select 'Options' > 'Preferences' > 'Commissioning'.

11 Commissioning

This chapter describes initial commissioning of the Cerberus PRO fire control panel (individual control panel, not networked).

- Activating access level
- Start auto-configuration
- Display C-NET line devices
- Enter customer texts for the control panel, C-NET and individual line devices via the control panel keypad

![Line tester FDUL221](image)

**NOTICE**

Connecting C-NET and line tester to the station at the same time

The line tester or station may be damaged.
- Do not connect C-NET and line tester to the station at the same time.

▷ C-NET is not yet connected to the station.
▷ Before commissioning and auto-configuration of the stations, the connected C-NET loops or stubs must be checked for correct function using the FDUL221 line tester.

1. Connect the line tester FDUL221 to the C-NET detector line.
2. Test the C-NET detector line for short-circuits, open lines, and ground faults.
3. Check the number of devices on the C-NET detector line based on the display on the line tester.
4. Check the branch-off position of the stubs and the number of devices at the stubs.
5. Check the type of the respective C-NET device.
6. Remedy any errors/faults which may be active before commissioning or auto-configuration

You will find information about line tester FDUL221 in document 008250.
11.1 Activating access level

The 'Station' is protected against unauthorized operation by access levels. Authorization for access level 3 is needed for the functions described below.

If the authorization code is not entered, operation is only possible in access level 1 (guest), e.g., for acknowledging the control panel buzzer or scrolling through the display messages.

The authorization code set in the factory is '0000'. This authorization code must be changed once the station has been configured.

Logout timeout
The 'Station' is provided with a time control function for the operation. The operation enable for an access level expires after a configurable period of time has passed since the last entry.

11.1.1 Log in / Change access level

You can enable an 'Access level' by entering your PIN in the PIN entry dialog, or by pressing <ok>. Alternatively you can use the key switch (optional) to release an Access level.

If you press a key on the ↑ Person Machine Interface whose function requires a higher 'Access level', the PIN input dialog is displayed automatically.

<table>
<thead>
<tr>
<th>Login/logout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter PIN:</td>
</tr>
<tr>
<td>Logout or guest-login: no PIN + &lt;ok&gt;</td>
</tr>
<tr>
<td>Confirm with &lt;ok&gt;/Exit with &lt;C&gt;</td>
</tr>
<tr>
<td>Delete with &lt;Cursor up&gt;</td>
</tr>
</tbody>
</table>

Table 6: PIN entry dialog box

Enabling an 'Access level' without a PIN
1. Press <Menu> on the keypad.
   ⊳ The PIN input dialog is indicated.
2. Do not enter a PIN and confirm with <ok>.
   ⊳ The lowest 'Access level' is enabled.
   ⊳ The main menu is open.

Enabling an 'Access level' with a PIN
1. Press <Menu> on the keypad or select the 'Main menu' > 'Login/logout' main menu item.
   ⊳ The PIN input dialog is indicated.
2. Enter your PIN and confirm with <ok>.
   ⊳ The corresponding 'Access level' is enabled.
   ⊳ The main menu is open.

The present 'Access level' is indicated in the main menu in the header of the display.
11.2 Auto-configuration of control panels

This function requires the control panel, components, and C-NET to have been correctly installed. Once auto-configuration is complete, the control panel is ready for detection with limitations. A fire is recognized by the connected fire detectors and displayed on the control panel. Configuration with the FXS7212 Cerberus Engineering Tool is required in order to assign controls, define individual alarm responses, and make adjustments in line with object-specific requirements.

- Every loop or stub line is tested with the line tester FDUL221 to ensure it is functioning and installed correctly.
- Run auto-configuration as described in the 'Auto-configuring a line' chapter.
- The station is ready to detect - with limitations. The C-NET devices have been addressed. Should an event occur, e.g. a triggered fire detector and its C-NET address are displayed.

11.2.1 Auto-configure line

The 'Line' element category in the 'Maintenance' menu facilitates the reading-in of the current topology, for example. This creates part of the elements in the 'Detection tree'.

- Customer text (e.g. detector number, installation location etc.) can be entered for each C-NET device for improved clarity.
Auto-configuring a line:

1. In the main menu, select the 'Topology' menu item.
   ➢ The 'Topology' window is open.
2. Select 'Hardware tree'.
   ➢ The 'Element' window is open.
3. Select 'Station' and press the 'Lower level' <softkey>.
   ➢ The elements of 'Station' are displayed.
4. Select the corresponding 'C-NET line card (onboard/FCL2001)' module and press the 'Lower level <softkey>.
   ➢ All lines of 'C-NET line card (onboard/FCL2001)' are indicated.
5. Select a line and press 'More Options' <softkey>.
   ➢ The 'Select option' window is open.
6. Select 'Execute commands' and confirm with <ok>.
   ➢ The window including the possible commands is displayed.
7. Select the 'Auto-configure line' command and confirm with <ok>.
   ➢ The line is auto-configured.

Display for auto-configuration

<table>
<thead>
<tr>
<th>Main menu</th>
<th>Access level 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit with &lt;C&gt;</td>
<td></td>
</tr>
<tr>
<td>Message summary</td>
<td>Element search</td>
</tr>
<tr>
<td>Functions</td>
<td>Event memory</td>
</tr>
<tr>
<td>Favorites</td>
<td>Login/logout</td>
</tr>
<tr>
<td>Topology</td>
<td>Settings/administration</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>All</td>
<td>test</td>
</tr>
</tbody>
</table>

- Select 'Topology', continue with <ok>

<table>
<thead>
<tr>
<th>Topology</th>
<th>Access level 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit with &lt;C&gt;</td>
<td></td>
</tr>
<tr>
<td>Detection tree</td>
<td>(1)</td>
</tr>
<tr>
<td>Hardware tree</td>
<td>(2)</td>
</tr>
<tr>
<td>Control tree</td>
<td>(3)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>All</td>
<td>test</td>
</tr>
</tbody>
</table>

- Select 'Hardware tree', continue with <ok>
001 Element

Station 1

---

005

<table>
<thead>
<tr>
<th>FC721</th>
<th>Elements</th>
<th>Main building</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module 1</td>
<td>Periphery board</td>
<td></td>
</tr>
<tr>
<td>Module 2</td>
<td>Periphery board</td>
<td></td>
</tr>
<tr>
<td>Module 3</td>
<td>'C-NET line card (onboard/FCL2001)'</td>
<td></td>
</tr>
<tr>
<td>Module 4</td>
<td>Communication interfaces</td>
<td></td>
</tr>
</tbody>
</table>

---

007

<table>
<thead>
<tr>
<th>Elements</th>
<th>Module 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>'C-NET line card (onboard/FCL2001)'</td>
<td></td>
</tr>
</tbody>
</table>

---

Select 'Station 1', continue with 'Lower level' <softkey 2>

Select 'Module 2', continue with 'Lower level' <softkey 2>

Select 'Line 1', continue with 'More Options' <softkey 3>

Selecting option

| Execute commands | (3) |
| Show details     | (5) |

Select 'Execute commands', continue with <ok>

Select command

| Read in installed devices | (1) |
| Detector line OFF         | (2) |
| Auto-configure line       | (3) |
| Set customer text         | (4) |
| Accept replaced devices   | (6) |

Select 'Auto-configure line', continue with <ok>

⇒ The line is auto-configured.
11.3 Displaying C-NET devices

After auto-configuration, the individual C-NET detector lines and the associated C-NET devices of each line can be displayed and configured.

Depending on the control panel type (2 or 4 loops) and the control panel design, the depiction may vary and several lines may be displayed.

You can display the lines and devices as follows. The displays are depicted in the same way as those in the ‘Auto-configuring a line’ chapter with the exception of the ‘Show details’ command.

At least one line is configured.

1. In the main menu, select the 'Topology' menu item.
   - The 'Topology' window is open.

2. Select 'Hardware tree'.
   - The 'Element' window is open.

3. Select 'Station' and press the 'Lower level' <softkey>.
   - The elements of 'Station' are displayed.

4. Select the corresponding 'C-NET line card (onboard/FCL2001)' Module and press the 'Lower level' <softkey>.
   - All lines of 'C-NET line card (onboard/FCL2001)' are indicated.

5. Select a line and press 'More Options' <softkey>.
   - The 'Select option' window is open.

6. Select 'Execute commands' and confirm with <ok>.
   - The window including the possible commands is displayed.

7. Select the 'Show details' command and confirm with <ok>.
   - The details are displayed.
Example of selecting a line

<table>
<thead>
<tr>
<th>004 Elements</th>
<th>Module 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-NET line card</td>
<td></td>
</tr>
<tr>
<td>(onboard/FCL2001)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Line</th>
<th>Line</th>
<th>Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Upper level</th>
<th>Lower level</th>
<th>More Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>004 Elements</th>
<th>Line 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>OH720</td>
</tr>
<tr>
<td>Device</td>
<td>HI720</td>
</tr>
<tr>
<td>Device</td>
<td>OP720</td>
</tr>
<tr>
<td>Device</td>
<td>OP720</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Upper level</th>
<th>Lower level</th>
<th>More Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Check whether all devices of this C-NET detector line are displayed correctly. You can use the type designation to detect the type of device displayed (smoke detector, heat detector, manual call point etc.)

You will find a list of type designations in the 'C-NET devices' chapter.

11.4 Entering/Changing customer text

You can enter customer text for any element on the control panel, independently of Cerberus-Engineering-Tool.

Once customer text has been entered or changed, the updated display is only shown the next time the element is accessed. Entering or changing customer text does not lead to a reboot.

'Set customer text'

1. Select an element
2. Press the 'Execute Commands' ↑ softkey.
3. Select the 'Set customer text' command.
4. Enter the desired customer text and confirm the entry with <ok>.
   ⊳ The customer text has been entered.

Changing customer text

Proceed in the same way as when entering customer text but change the existing customer text.
11.5 Setting the system time

The set system time is used to log all the control panel's messages, save them in the event memory and output them on a connected printer.

11.5.1 Setting time and date

You will have to reset the clock if the fire control panel has been de-energized. In countries with central European summer time (CEST), the system clock automatically switches between daylight savings time and regular time.

'Enter date / time'

1. Select 'Main menu' > 'Settings/administration' > 'System commands'.
   ⇨ The 'System commands' window is open.
2. Select 'Set system time'.
   ⇨ The 'Enter date / time' window is open.
3. Enter the date and time and/or confirm with <ok>.
   ⇨ The cursor jumps to the next field and terminates the input after the last field.
   ⇨ Adjusted or confirmed date and time are set.

<table>
<thead>
<tr>
<th>Enter date / time</th>
</tr>
</thead>
<tbody>
<tr>
<td>24-04-09 12:42:58</td>
</tr>
<tr>
<td>(dd-mm-yy) (hh:mm:ss)</td>
</tr>
<tr>
<td>Confirm with &lt;ok&gt;/Exit with &lt;C&gt;</td>
</tr>
<tr>
<td>Delete with &lt;Cursor up&gt;</td>
</tr>
</tbody>
</table>

*Table 7: Input window for time and date*
11.6  Changing access authorization PIN

After successful commissioning, the 8-digit access authorization (PIN) for the corresponding access level must be changed. Keep the new PIN in a safe place. If the PIN is lost, a system reset must be undertaken to the station's factory setting. The control panel configuration, including all customer data, is cleared in the process. The '00000000' PIN set in the factory applies again after a system reset.

11.6.1  PIN administration

You can change an existing PIN and create a new PIN or delete a PIN with the corresponding authorization.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>System manipulation due to unauthorized access</td>
</tr>
<tr>
<td>No alarm in a fire.</td>
</tr>
<tr>
<td>• Change the preset PIN.</td>
</tr>
<tr>
<td>• Create an 8-figure PIN according to the IT security requirements from Siemens; see PIN guidelines.</td>
</tr>
</tbody>
</table>

PIN administration not available

If PIN administration is not available at the station, you must configure the PINs in Engineering Tool. You will find more information in document A6V10210424.

'Change PIN'

1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.
2. Select the 'Change PIN' menu item.
3. Enter the PINs in accordance with the input fields and confirm with <ok>.
   ⇒ The PIN has been changed.

<table>
<thead>
<tr>
<th>Change PIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old PIN:     ********</td>
</tr>
<tr>
<td>New PIN:     ********</td>
</tr>
<tr>
<td>Verify new PIN:  ********</td>
</tr>
</tbody>
</table>

Confirm with <ok>/Exit with <C>  
Delete with <Cursor up>
'Create PIN'

- You have the required authorization level.
1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.
2. Select the 'Create PIN' menu item.
3. Enter an admissible access level.
4. Enter the PIN in accordance with the input fields and confirm with <ok>.
   ▶ A new PIN has been created.

```
Create PIN

Access level:    __
Enter PIN:    ********
Verify PIN:    ********

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>
```

See also
- PIN guidelines [→ 17]

'Delete PIN'

- PIN is present.
- You have the required authorization level.
1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.
2. Select 'Delete PIN'.
3. Enter the PIN in accordance with the input fields and confirm with <ok>.
   ▶ PIN has been deleted.

```
Delete PIN

Enter PIN:    ********
Verify PIN:    ********

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>
```
11.7 Restart the station

The configuration of the 'Station' remains the same.

There are the following ways in which to restart the 'Station':
- Via the menu on the display
- PMI & mainboard FCM2004 and FCM2027: With the 'S32' button
- CPU card: With the 'S8' button

Via the menu on the display
If you are using two CPU cards, you must perform the following procedure once for each CPU card.
1. Press <MENU>.
   - The PIN input dialog is displayed.
2. Enter a valid PIN and confirm with <ok>.
   - The 'User successfully logged in' message is displayed.
   - The main menu is displayed.
3. Select the 'Topology' > 'Hardware tree' > 'Station' menu items.
   - The elements of the 'Station' are listed.
4. Select module 101 or module 102 'CPU (FCC 2001/06)'.
5. Press the 'More Options' softkey and select 'Execute commands'.
6. Select the 'Reset module' command.
   - The 'Station' shuts down.
   - The 'Station' is switched off for several seconds.
   - The 'Station' restarts.

PMI & mainboard FCM2004 and FCM2027

- Switches S38-1 and S38-2 are set to the 'OFF' position on the PMI & mainboard FCM2004.
- On the PCB of the operating unit, press and hold down the 'S32' button for <2 s.
   - The 'Station' shuts down.
   - The 'Station' is switched off for several seconds.
   - The 'Station' restarts.
11.8 Calibrating an FDnet/C-NET detector line

General

**WARNING**

Impermissible line configuration

An impermissible line configuration can cause the alarm devices connected to this line to be supplied with insufficient power in the event of a fire. This prevents the alarm from sounding in the corresponding parts of a building. This can cause serious injuries or death.

- Make sure that all lines of a line card have a permissible line configuration by calibrating them successfully. You will find information about the requirements for a permissible line configuration in the ‘Planning detector lines’ chapter of the document 'A6V10210362'.

Line calibration enables users to check whether sufficient power is being supplied to all devices in an installed line during commissioning and ongoing operations; the power supply can even be checked in the event of an alarm. This is particularly helpful when the line topology or power-relevant configuration parameters of a line are changed.

Another objective of line calibration is to determine how much additional line resistance $\Delta R_{\text{max}}$ is possible before the line devices fall below the required supply voltage in case of corrosion, gradual cable breakage, or thermal drift.

In the event of thermal drift, the line resistance $R_{\text{Line}}$ increases by $\approx 0.4 \%/ ^\circ C$.

In an unheated warehouse, the difference in temperatures under the ceiling in summer and winter could amount to 50 °C. This could lead to the line resistance being $\approx 20 \%$ higher in summer than it is in winter.

The line calibration also shows the maximum possible current consumption of all line devices per line card.
**Time of a line calibration process**

The time of a line calibration process depends on how this has been configured in the 'Cerberus-Engineering-Tool' for each individual line. The following configuration modes are available:

- 'Automatic with manual recalibration'
- 'Automatic without manual recalibration'
- 'Manual'
- ' - (disabled)'

In the default settings, a line is set to 'Automatic with manual recalibration' in the configuration. You will find information on configuring the line calibration in document 'A6V10210424'.

The duration of a line calibration consists of a 45-second base time plus about 1 second per installed 'Voice alarm sounder beacon/Voice al. sound. beacon base' device on the line to be calibrated. This means a line with 252 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices can be calibrated in about 5 minutes.

### Calibration modes

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Line calibration mode'</td>
<td>'Automatic without manual recalibration'</td>
<td>Calibration of the selected line takes place automatically each time the line card is restarted if a setting relevant to power consumption has been adjusted. Manual recalibration of the line is not possible during active operation.</td>
</tr>
<tr>
<td>'Automatic with manual recalibration'</td>
<td></td>
<td>Calibration of the selected line takes place automatically each time the line card is restarted if a setting relevant to power consumption has been adjusted. Manual recalibration of the line is possible during active operation.</td>
</tr>
<tr>
<td>'Manual'</td>
<td></td>
<td>Calibration of the selected line can only be triggered manually on the 'PMI'.</td>
</tr>
<tr>
<td>' - (disabled)'</td>
<td></td>
<td>Calibration of the selected line is deactivated.</td>
</tr>
</tbody>
</table>
11.8.1 Automatic line calibration

The line must be configured for automatic line calibration so that the system can perform the process if necessary. You will find information on configuring the line calibration in document 'A6V10210424'.

The station does not block the execution of a line calibration if some devices are active on the line to be calibrated at this time. The station only blocks line calibration if the station is in alarm condition.

The system automatically calibrates a line in the following cases after restarting the fire control panel for the line card or the line:

- The line topology has changed.
- The configuration of the brightness level and/or the sound level of the sounders has changed.

After each line calibration, the system saves a signature of all parameters and their values that affect the power consumption of the line. After every restart, the signature for the line is recalculated and compared against the signature for the last calibration. If this comparison reveals that the signatures are different, the line is automatically recalibrated.

In the following case, you need to manually calibrate all lines of a periphery board or a line card, even if automatic calibration is activated:

- A periphery board with an integrated line card has been changed.
- A line card has been changed.

If the 'Automatic without manual recalibration' calibration mode is configured for a line, then it must first be changed to the 'Automatic with manual recalibration' or 'Manual' calibration mode in the configuration. Otherwise, it will not be possible to manually calibrate the line.

11.8.2 Manual line calibration

Calibrate a line manually on the 'PMI' in the following cases if automatic line calibration is deactivated in the configuration of the line:

- The line topology has been changed.
- The configuration of the brightness level and/or the sound level of the sounders has changed.
- The PMI displays a calibration error for a line.

Calibrate all lines of a periphery board or a line card manually on the 'PMI' in the following cases, even if automatic line calibration has been activated in the configuration of the line:

- A periphery board with an integrated line card has been changed.
- A line card has been changed.

If the 'Automatic without manual recalibration' calibration mode is configured for a line, then it must first be changed to the 'Automatic with manual recalibration' or 'Manual' calibration mode in the configuration. Otherwise, it will not be possible to manually calibrate the line.
Calibrating lines manually

The duration of a line calibration consists of a 45-second base time plus about 1 second per installed 'Voice alarm sounder beacon/Voice al. sound. beacon base' device on the line to be calibrated. This means a line with 252 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices can be calibrated in about 5 minutes.

The station does not block the execution of a line calibration if some devices are active on the line to be calibrated at this time. The station only blocks line calibration if the station is in alarm condition.

- The fire control panel has started up.
- There are no alarms present on the fire control panel.
- The configuration of the line permits manual calibration. You will find more information about this in document 'A6V10210424'.
- Required access level: 3

1. Open the following path in the main menu on the 'PMI':
   'Topology' > 'Hardware tree' > 'Station xx' > 'C-NET line card xx'
   ➔ The display shows the menu for the line card in question.
2. In the 'C-NET line card xx' menu, highlight the line you want to calibrate.
3. Select the 'More options' function in the softkey bar.
   ➔ The display shows a list.
4. In the list, select the following: 'Execute commands' > 'Calibrate'
   ➔ The system calibrates the selected line and then stores the calibration report for the line.

11.8.3 Calibration report

The calibration report contains the main measurement results or the calibration figures for a line calculated from these results.

Displaying the calibration report on the 'PMI'

- Required access level: 3

1. Open the following path in the main menu on the 'PMI':
   'Topology' > 'Hardware tree' > 'Station xx' > 'C-NET line card xx'
   ➔ The display shows the menu for the line card in question.
2. In the 'C-NET line card xx' menu, highlight the line for which you require the calibration report.
3. Select the 'More options' function in the softkey bar.
   ➔ The display shows a list.
4. In the list, select the following: 'Execute commands' > 'Calibration report'
   ➔ The display shows the calibration report.
5. Use the navigation keys to navigate through the entries in the calibration report. You will find more information about the individual entries in the section 'Calibration report' below.
**Figures and calculation variables**

In the following section, you will find the main figures and calculation variables needed to understand and interpret the calibration report.

Line calibration for lines with a stub topology has a reduced functional scope as certain calculation variables cannot be measured.

<table>
<thead>
<tr>
<th>Figure / calculation variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I_{\text{quiet}}$</td>
<td>The measured power consumption of a line in an quiescent condition.</td>
</tr>
<tr>
<td>$I_{\text{nom}}$</td>
<td>Calculated nominal power consumption of all devices in an alarm scenario. $I_{\text{nom}} = I_{\text{Line[01]}} + \sum \text{load compensation non-'Voice alarm sounder beacon/Voice al. sound. beacon base' devices}$ The nominal power consumption is made up of the measured power consumption of all 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line and the calculated compensation value for all non-'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line.</td>
</tr>
<tr>
<td>$I_{\text{max}}$</td>
<td>Calculated maximum power consumption of all devices in an alarm scenario with a simultaneous cable break directly at the connection terminal or a short-circuit. $I_{\text{max}} = \max(I_{\text{cable break at terminal&lt;A,B&gt;}}) + \sum \text{load compensation non-'Voice alarm sounder beacon/Voice al. sound. beacon base' devices}$ Information: For the calculation, the system takes the larger measured value for an assumed cable break on connection terminals A or B.</td>
</tr>
<tr>
<td>$I_{\text{tot}}$</td>
<td>The calculated total power consumption of the line card in an alarm scenario.</td>
</tr>
<tr>
<td>$R_{\text{Line}+}$</td>
<td>The measured line resistance on the plus wire of the line.</td>
</tr>
<tr>
<td>$R_{\text{Line}-}$</td>
<td>The measured line resistance on the minus wire of the line.</td>
</tr>
<tr>
<td>$\Delta R_{\text{max}}$</td>
<td>The calculated tolerance of the line when faced with a gradual cable break and thermal drift. The value reveals how much additional line resistance the line can still withstand without the individual line devices falling below their required supply voltage in an alarm scenario and in the worst assumed underlying conditions*. The following applies for a permitted line: $\Delta R_{\text{max}} &gt; 0 \Omega$</td>
</tr>
<tr>
<td>$U_{\text{device}}$</td>
<td>The measured voltage on an 'Voice alarm sounder beacon/Voice al. sound. beacon base' line device in the worst assumed underlying conditions*.</td>
</tr>
</tbody>
</table>

* The worst possible underlying conditions include a gradual cable break directly on one of the line's connection terminals and a maximum assumed thermal drift of $\Delta T = 10 \, ^\circ\text{C}$. 
## Entries in the calibration report

<table>
<thead>
<tr>
<th>Entry in the calibration report</th>
<th>Possible content*</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Header:</strong> Line 1/2/1</td>
<td>Report Calibration 2018-04-24 10:11:12</td>
<td>Information on the line created for the calibration report.</td>
</tr>
</tbody>
</table>
| **1. Calibration status**       | Line 1/2/1 UNCALIBRATED Loop 1_1/1_2 | The entry indicates the calibration status for the line. The calibration may have the following status:  
   - **Uncalibrated:** There is no data on a previously completed calibration process for a line in the system. |
|                                 | Line 1/2/1 CALIBRATED - PASS Loop 1_1/1_2 |  
   - **Calibrated:** There is data on a previously completed calibration process for a line in the system. The entry also shows whether the calibration was successful. |
|                                 | Line 1/2/1 CALIBRATED - FAIL Loop 1_1/1_2 |  
   - **Recalibration required:** During active operation, this indicates whether the line needs to be recalibrated. The data from the last calibration is no longer valid as the line topology and/or configuration parameters have been changed in a way that affects the power consumption of the line. |
| **2. Time since last calibration** | Date/time: 2018-04-20 11:12:13 Line 1/2/1 PASS | The entry shows the last time the line was calibrated and whether the calibration process was successful. |
| **3. Power consumption of the line card** | FDnet line card Module 1/2 PASS Itot = 499 mA | The entry shows the entire power consumption of the line card in an alarm scenario. The following results are possible:  
   - **Pass:** The power consumption of the line is below the maximum load capacity of the line card of 0.5 A. |
|                                 | FDnet line card Module 1/2 FAIL Itot = 580 mA |  
   - **Fail:** The power consumption of the line is above the maximum load capacity of the line card of 0.5 A. |
|                                 | FDnet line card Module 1/2 UNKNOWN Itot = 420 mA |  
   - **Unknown:** The entire power consumption of the line card is unknown as either some of the lines on the card have not been calibrated or line calibration for certain lines has been deactivated. The displayed power consumption is the sum of all calibrated lines on the line card. |
<table>
<thead>
<tr>
<th>Entry in the calibration report</th>
<th>Possible content*</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4. Power consumption of the line (nominal) | Loop 1_1/1_2 Line 1/2/1 PASS $I_{nom} = 500\, mA$ | The entry indicates the calculated value for the nominal power consumption of the line. This is made up of the measured power consumption of all 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line and the calculated compensation value for all non-'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line. The following results are possible:  
• **Pass**: The calculated nominal power consumption is below 0.5 A.  
| Loop 1_1/1_2 Line 1/2/1 FAIL $I_{nom} = 600\, mA$ | **Fail**: The calculated nominal power consumption is above 0.5 A. |
| 5. Power consumption of the line (maximum) | Loop 1_1/1_2 Line 1/2/1 PASS $I_{max} = 499\, mA$ | The entry indicates the calculated maximum power consumption of the line. This is made up of the maximum power consumption of all 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices in the event of an open line directly at the connection terminal and the calculated compensation value for all non-'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line. The following results are possible:  
• **Pass**: The calculated maximum power consumption is below 0.5 A.  
| Loop 1_1/1_2 Line 1/2/1 FAIL $I_{max} = 649\, mA$ | **Fail**: The calculated maximum power consumption is above 0.5 A. |
| 6. Power consumption of the line while idling | Loop 1_1/1_2 Line 1/2/1 PASS $I_{quiet} = 12\, mA$ | The entry shows the measured power consumption of the line in an unloaded state. |
| 7. Line resistance - Plus | Loop 1_1/1_2 Line 1/2/1 PASS ..... $R_+ = 12.3\, \Omega$ | The entry shows the measured line resistance on the line's plus cable in ohm ($\Omega$). |
| 8. Line resistance - Minus | Loop 1_1/1_2 Line 1/2/1 PASS ..... $R_- = 12.5\, \Omega$ | The entry shows the measured line resistance on the line's minus cable in ohm ($\Omega$). |
| 9. Tolerance of the line resistance | Loop 1_1/1_2 Line 1/2/1 PASS ..... $dR_{max} = 20.0\, \Omega$ | The entry shows the calculated value for the maximum tolerance of the line when faced with a gradual line break and thermal drift.  
The following results are possible:  
• **Pass**: The calculated difference to the current line resistance is $>0\, \Omega$.  
| Loop 1_1/1_2 Line 1/2/1 FAIL ..... $dR_{max} = -2.1\, \Omega$ | **Fail**: The calculated difference to the current line resistance is $\leq 0\, \Omega$. |
## Entry in the calibration report

<table>
<thead>
<tr>
<th>Possible content*</th>
<th>Description</th>
</tr>
</thead>
</table>
| 10th to max. 252nd Voltage drop on the individual 'Voice alarm sounder beacon/Voice al. sound. beacon base' devices on the line | Entries 10 to max. 252 show the calculated voltage drop on each 'Voice alarm sounder beacon/Voice al. sound. beacon base' device in the line. The following results are possible:  
  - Pass: The calculated operating voltage for the 'Voice alarm sounder beacon/Voice al. sound. beacon base' device in question is $\geq 16$ V for devices with beacon and $\geq 12$ V for devices without beacon. |
| FDS227 - RR Device 1/2/1/1 PASS U = 23.4 V                                         |                                                                                                                                             |
| FDS227 - RR Device 1/2/1/1 FAIL U = 15.7 V                                         |  
  - Fail: The calculated operating voltage for the 'Voice alarm sounder beacon/Voice al. sound. beacon base' device in question is $< 16$ V for devices with beacon and $< 12$ V for devices without beacon. |

* The specified lines, devices, and values are only examples.
11.9 Detailed commissioning steps

In the following chapters, you will find detailed commissioning steps that are referred to in several chapters.

11.9.1 Preparing 'Station' for commissioning

1. Connect the cables for the ↑ detector lines and the peripheral devices.

2. Connect the power supply (mains and batteries).
   ⇨ The ↑ 'Station' starts and reads in the internal hardware.
   ⇨ During start-up, the 'FAULT' LED flashes and the display shows the progress.
   ⇨ During start-up, the firmware version F-FXS7211 is displayed.

3. Wait until the display indicates the selection of the ↑ BDV.

4. Press the 'Install' ↑ softkey and confirm with the 'Yes' softkey.
   ⇨ The 'Station' restarts.
   ⇨ During this process, the 'FAULT' LED flashes and the display shows the progress.

5. Wait until only the green 'System On' LED lights up, the display shows the normal condition, and the 'Station' can be operated.

6. Press <MENU> and select the 'Login/logout' menu item.
   ⇨ You are prompted to enter a PIN.

7. Enter the PIN and confirm with <ok>.
   ⇨ The 'User successfully logged in' message is displayed.
   ⇨ The main menu is shown on the display.

8. Check the firmware of the 'Station' to ensure that it is up to date. To do this, select the 'Topology' > 'Hardware tree' > 'Station' > 'More Options' > 'Show details' menu items.
   ⇨ The 'Station' version and configuration data are displayed.

9. Update the firmware if necessary.

10. Enter the date and time. To do this, select the 'Settings/administration' > 'System commands' > 'Set system time' menu items.

Additional messages may be displayed depending on the configuration of the 'Station'.
11.9.2 Preparing 'Station' for commissioning – without BDV installation

1. Connect the cables for the ↑ detector lines and the peripheral devices.
2. Connect the power supply (mains and batteries).
   - The ↑ 'Station' starts and reads in the internal hardware.
   - During start-up, the 'FAULT' LED flashes and the display shows the progress.
   - During start-up, the firmware version F-FXS7211 is displayed.
3. Wait until the display indicates the selection of the ↑ BDV.
   - The 'Station' is prepared for commissioning.

It is not necessary to install the BDV for the further procedure. This saves having to restart the 'Station'.

Following preparation, you can for instance perform the following steps, depending on the selected commissioning variant:
- Initialize the 'Station'
- Auto-configure the 'Station'
- Load the configuration from the PC to the 'Station'

11.9.3 Auto-configuring 'Station'

1. Select 'Topology' > ↑ 'Hardware tree' > ↑ 'Station' in the main menu.
2. Press the 'More Options' ↑ softkey and select 'Execute commands'.
3. Select the 'Auto-configure station' command.
   - The 'Station' is auto-configured.
   - The following message is shown following successful ↑ auto-configuration: 'Command executed'
11.9.4 Auto-configuring the detector line

**NOTICE**

Incorrect order for reading in a loop, no isolation of second 'Line'

Error when reading in a loop

The C-NET detector lines are detected as stubs during the first system startup, e.g., 'Line' 11, 'Line' 12 (2-digit line number), even if they are connected as a loop.

- Before you proceed to reading in the first 'Line', you must isolate the second 'Line'.
- To read in a loop, always select the first 'Line', in this case 'Line' 11. 'Line' 12 is then read in automatically and a loop is displayed with a 1-digit line number, in this case as 'Line' 1.
- Proceed in the same way from 'Line' 21/22 (loop 2) to 'Line' 41/42 (loop 4).

**NOTICE**

Overwriting an existing configuration

Parts of an existing customer-specific configuration are lost.

- First save an existing customer-specific configuration.

1. Select 'Main menu' > 'Topology' > 'Hardware tree' > 'Station' > 'Module' (line card) > 'Line'.
2. Press the 'More Options' softkey and select 'Execute commands'.
3. Select the 'Auto-configure line' command.
   - The C-NET detector line is auto-configured.
   - The following message is shown following successful auto-configuration: 'Command executed'
11.9.5 Loading automatically created configuration to the PC

The description in this chapter only applies if a configuration has not yet been loaded to the 'Station' and if the ↑ BDV was installed at the 'Station' after the 'Station' was started for the first time.

1. Select the 'File' > 'New site' menu item.
   ⇧ The 'Create new site' window opens.
2. Select the 'Upload from station(s)' option field.
3. Click on 'Next'.
   ⇧ The 'Create site by uploading from station(s)' and 'Connect' windows open.
4. In the 'Connect' window, select 'Local connection' and then click on 'OK'.
   ⇧ The configuration is loaded to 'Cerberus-Engineering-Tool'.
   ⇧ The progress is displayed in the 'Create site by uploading from station(s)' window.
   ⇧ The 'Site properties' window is opened after loading.
5. Change the entries if required and click on 'OK'.
   ⇧ The 'New site confirmation' window opens.
6. Click on 'Yes'.
   ⇧ The 'Site' is opened in Cerberus-Engineering-Tool.

11.9.6 Adapting configuration

Adapt the configuration of the ↑ Site ↑ in Cerberus-Engineering-Tool, e.g.:
- Changing customer texts
- Setting the properties and the ↑ parameter sets
- Changing the assignment of ↑ 'Zones' and ↑ 'Sections'
- Configuring controls
- Configuring the operating and display units
- Configuring the network

You will find information about configuring a 'Site' in document A6V10210424. See chapter ‘Applicable documents’.

11.9.7 Switch off

11.9.7.1 Safety during switch-off

⚠️ WARNING

System parts that have been switched off make it impossible to acquire and process alarms or faults!
Fire may spread unhindered.
- Deploy staff to monitor the deactivated area.
- You must switch deactivated parts of the 'Site' back on as soon as possible.
11.9.7.2 Switching off the detector line

1. Select 'Main menu' > 'Topology' > ↑ 'Hardware tree' > ↑ 'Station' > ↑ line card > ↑ detector line.
2. Press the 'More Options' ↑ softkey and select 'Execute commands'.
3. **WARNING!** System parts that have been switched off make it impossible to acquire and process alarms or faults! Select the 'Detector line OFF' command.
   - The yellow 'ISOLATION' LED lights up.
   - The detector line is switched off.

11.9.7.3 Switch off zone

1. Select 'Topology' > ↑ 'Detection tree' > ↑ 'Area' > ↑ 'Section' > ↑ 'Zone' in the main menu.
2. Press the 'More Options' softkey and select 'Execute commands'.
3. **WARNING!** System parts that have been switched off make it impossible to acquire and process alarms or faults! Select the 'Off' command.
   - The yellow 'ISOLATION' LED lights up.
   - The 'Zone' is switched off.

11.9.8 Switching on

11.9.8.1 Switch on detector line

1. Select 'Main menu' > 'Topology' > ↑ 'Hardware tree' > ↑ 'Station' > ↑ line card > ↑ detector line.
2. Press the 'More Options' ↑ softkey and select 'Execute commands'.
3. Select the 'Detector line ON' command.
   - The yellow 'ISOLATION' LED goes out.
   - The detector line is switched on.

11.9.8.2 Switch on zone

1. Select 'Topology' > ↑ 'Detection tree' > ↑ 'Area' > ↑ 'Section' > ↑ 'Zone' in the main menu.
2. Press the 'More Options' softkey and select 'Execute commands'.
3. Select the 'On' command.
   - The yellow 'ISOLATION' LED goes out.
   - The 'Zone' is switched on.
11.9.9 Restarting the detector line

**WARNING**

**Activation of fire or smoke dampers**

If fire or smoke dampers are connected to the FS720 via an input/output module, they may be activated when the station is switched off or when the station or detector line is restarted.

- If necessary, block the outputs temporarily [➡️ 110] before switching off the station or restarting the station/detector line.

1. Select 'Main menu' > 'Topology' > ↑ 'Hardware tree' > ↑ 'Station' > 'Module' (line card) > 'Line'.
2. Press the 'More Options' ↑ softkey and select 'Execute commands'.
3. Select the 'Restart line' command.
   - The ↑ detector line is restarted. The following messages are displayed:
     - 'Line starting up'
     - 'Device config.runs'

**Start line test**

Only test the line and line devices once the following messages have disappeared from the PMI:
- 'Device config.runs'
- 'System startup completed'

11.9.10 Freezing outputs

You can freeze outputs with connected fire dampers to prevent them from being activated if the 'Station' or line is restarted or in the event of a module reset. A restart is required if a modified configuration is loaded to the 'Station'.

**Duration of freeze**

The output freeze lasts until the next restart or module reset. It is deactivated after the restart or module reset. See chapter 'Enabling frozen outputs [➡️ 111]' for how to manually deactivate freezing.

- All line devices are switched on.
- Input/output modules with connected fire dampers are present on the line.
- The output freeze is activated / configured in the ↑ 'Site' configuration. See document A6V10210424.

1. At the 'Station', select the 'Station', a module, or a line in the hardware tree.
2. Select 'Execute Commands' > 'Freeze selected outputs ON'.
3. The 'Output positions frozen' message is displayed for the frozen outputs.
   - You can now restart the 'Station' or the line or perform a module reset.
11.9.11 Enabling frozen outputs

- One or more outputs have been frozen / the 'Output positions frozen' message is displayed for one or more outputs.
- All line devices are switched on.

1. At the 'Station', in the hardware tree select the 'Station', the module, or the line that has been frozen or select the 'Output positions frozen' message for the corresponding element.

2. Select 'Execute Commands' > 'Freeze selected outputs OFF'.
   - Freezing of the outputs is deactivated.

11.9.12 Read in devices on detector line

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect order for reading in a loop</td>
</tr>
<tr>
<td>Error when reading in a loop.</td>
</tr>
<tr>
<td>The C-NET detector lines are detected as stubs during the first system start-up, e.g., 'Line' 11, 'Line' 12 (2-digit line number), even if they are connected as a loop.</td>
</tr>
<tr>
<td>• For loop with line separator: Switch the second 'Line' or 'Line' 12 off.</td>
</tr>
<tr>
<td>• To read in a loop, always select the first 'Line', in this case 'Line' 11. 'Line' 12 is then read in automatically.</td>
</tr>
<tr>
<td>• A loop is displayed with a 1-digit line number, in this case as 'Line' 1 once it has been read in.</td>
</tr>
<tr>
<td>• Proceed in the same way from 'Line' 21/22 (loop 2) to 'Line' 41/42 (loop 4).</td>
</tr>
</tbody>
</table>

- For ↑ loop with line separator: The second 'Line' is switched off. Link [109]

1. In the main menu, select 'Topology' > ↑ 'Hardware tree' > ↑ 'Station' > ↑ line card > ↑ detector line.

2. Press the 'More Options' ↑ softkey and select 'Execute commands'.

3. Select the 'Read in installed devices' command.
   - The C-NET devices are read in.
   - The following message is shown following successful reading in: 'Command executed'

11.9.13 Detaching the device

If you want to permanently remove a device, uninstall the device – and, if necessary, the base – and connect the wires of the detector line.

You will find more information about installing and uninstalling in the documentation for the corresponding device.
11.9.14 **Delete the device on Person Machine Interface**

1. Mark the corresponding device fault message.
2. Press the 'More Options' softkey.
3. Select the 'Show topology' menu item.
   ⇦ The logical channel is displayed. For some devices, 'Device' is displayed directly.
4. Press the 'More Options' softkey.
5. Select the 'Jump to link' menu item.
   ⇦ The physical channel is displayed.
6. Press the 'Upper level' softkey.
   ⇦ 'Device' is displayed.
7. Press the 'More Options' softkey.
8. Select the 'Execute commands' menu item.
9. Select the 'Remove/delete device' command.
   ⇦ The control panel deletes the physical representation of the removed device.
   ⇦ The logical channel element remains in the 'Zone'.

11.9.15 **Remove the elements**

If you have uninstalled an C-NET device for good, the corresponding elements, e.g. the 'Cerberus-Engineering-Tool' must be removed from the logical structure trees in Zone. You can search for elements using the 'Find' function.

You will find more information in document A6V10210424. See chapter 'Applicable documents'.

11.9.16 **Testing detectors**

The commissioning personnel perform the function test for the automatic fire detectors and the 'Manual call points'.

You will find additional information about the individual steps on the specified pages.

▷ The detector line has been commissioned.
1. Switch the test mode on. Link [➔ 113]
2. Initiate the detector. Link [➔ 113]
3. Switch normal operation on. Link [➔ 114]
4. Test the logged test activations. Link [➔ 113]
11.9.16.1 Activate the detector

▷ DETECTOR TEST is switched on.
1. Activate all automatic 'Detectors' and 'Manual call points' using the corresponding tools.
2. Write down the sequence of the test activations.
   - The ↑ alarm indicator for the activated detector flashes at each test activation.
   - If an ↑ external alarm indicator is connected and correspondingly configured, the external alarm indicator also lights up.

You will find information about triggering detectors in document A6V10212047. See chapter 'Applicable documents'.

11.9.16.2 Testing logged test activations

1. Test the logged test activations. This can be done in two ways:
   - ↑ Person Machine Interface: Select 'Event memory' in the main menu.
   - Cerberus-Engineering-Tool: Select the 'Commissioning' > 'Upload site event memory' menu items.
2. Rectify existing errors if necessary, e.g. if the alarm indicator has not flashed or no test entries exist.

11.9.17 Switching on test mode

1. Select 'Topology' > ↑ 'Detection tree' in the main menu.
2. Select the element you want to switch to test mode: ↑ 'Area', ↑ 'Section', or ↑ 'Zone'
3. Press the 'More Options' ↑ softkey and select 'Execute commands'.
4. Select a command from the following table.
   - The yellow 'Detector test' LED lights up.
   - The element is in test mode.

<table>
<thead>
<tr>
<th>Element</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>'Non-MCP zones det.test'</td>
</tr>
<tr>
<td></td>
<td>'MCP zones det.test'</td>
</tr>
<tr>
<td>Section</td>
<td>'Non-MCP zones det.test'</td>
</tr>
<tr>
<td></td>
<td>'MCP zones det.test'</td>
</tr>
<tr>
<td>Zone</td>
<td>'Detector test'</td>
</tr>
</tbody>
</table>
11.9.18 Switch on normal operation

There is a shortened procedure for switching individual 'Zones' to normal operation. The procedure is described in the following section: 'Switching 'Zone' to normal operation'.

Switching 'Area', 'Section' or 'Zone' to normal operation

1. Select 'Topology' > 'Detection tree' in the main menu.
2. Select the element you want to switch to normal operation: 'Area', 'Section', or 'Zone'.
3. Press the 'More Options' softkey and select 'Execute commands'.
4. Select a command from the following table.
   - The element is switched to normal operation.
   - The yellow 'Detector test' LED goes out.

<table>
<thead>
<tr>
<th>Element</th>
<th>Command</th>
</tr>
</thead>
</table>
| Area    | 'Non-MCP zones det.test END'  
          | 'MCP zones det.test END' |
| Section | 'Non-MCP zones det.test END'  
          | 'MCP zones det.test END' |
| Zone    | 'Detector test END' |

Commands under 'Execute commands'

You can also switch to normal operation at superordinate level for the command in question. Test mode can also be exited in the 'Zone', 'Section' or 'Area', for example.

Switching 'Zone' to normal operation

There is a shortened procedure for switching individual 'Zones' to normal operation:

1. Select 'Message summary' > 'Test message' in the main menu.
2. Select the displayed 'Zone' in test mode and press the 'Execute Commands' softkey.
3. Select the 'Detector test END' command.
   - The 'Zone' is switched to normal operation.
   - The yellow 'Detector test' LED goes out.
11.9.19 **Rectify localization errors**

1. Use 'Topology' > 'Hardware tree' > ↑ 'Station' > ↑ Line card > Detector line to select the corresponding ↑ detector line in the main menu.
2. Press the 'More Options' ↑ softkey and select 'Execute commands'.
3. Select the 'Accept replaced devices' command.
   - The fault messages are no longer displayed.

If devices are missing or the device types do not correspond to the C-NET topology, error messages will continue to be displayed.

11.9.20 **Checking 'Site' function**

Test the function of the ↑ 'Site' in the various test modes.

You will find information on testing a 'Site' in the 'Testing' chapter of document A6V10211076. See chapter 'Applicable documents'.

11.9.21 **Carrying out final commissioning work**

**Checking the date and time**

1. Check the date and time.
2. Adjust the date and time, if required.
   - To do this, select 'Settings/administration' > 'System commands' > 'Set system time' in the main menu.

**Setting the PIN for access levels**

1. Set the PIN for access levels 1, 2.1, 2.2, and 3.
   - To do this, select 'Settings/administration' > 'Manage PINs' in the main menu.
2. Fit the housing cover.
3. Label the installation plate, which should be outside on the housing, with the site number and the date of commissioning.
   - To do this, use a solvent-resistant pen.

**See also**

PIN guidelines [→ 17]
12 Remove or replace non-stationary C-NET devices

If a C-NET device is removed, the loop contact prevents the C-NET line from being interrupted and thereby prevents a fault message. The work described in this chapter may be performed when the C-NET line is switched on.

12.1 Temporarily remove an individual non-stationary C-NET device

It may be possible that a C-NET device must be temporarily removed from the base. Afterwards the same device must be re-inserted at exactly the same place in the C-NET.

Procedure
1. Remove the device.
   - The control panel detects that the device is missing and reports a 'Fault'.
2. Perform the necessary activities.
3. Re-insert the device in the C-NET in the same, previous position.
4. Acknowledge the 'Fault'.
   - If the 'Fault' is no longer displayed, the control panel updates the settings of the re-inserted device.
   - If this 'Fault' is still displayed, and/or the 'Line' is not in normal operation, the 'Line' has to be restarted.

12.2 Temporarily removing multiple non-stationary devices

The procedure in this chapter applies both for the base with loop contact and the base without loop contact.

For the purpose of painting work, it may be necessary to temporarily remove the C-NET devices in a room. Each C-NET device must then be re-inserted in its original base. The C-NET devices may not be exchanged.

Mark the allocation of the devices to the respective base to avoid additional work steps.

You will find additional information about the individual steps on the specified pages.

1. Switch the 'Zone' off. Link [117]
2. Remove the C-NET devices from their bases.
3. Perform the tasks.
4. Re-insert the C-NET devices to the respective position.
5. **Switch the 'Zone' on. Link [➙ 117]**
   - For all the re-inserted C-NET devices, a localization fault is displayed.

6. **Restart the C-NET detector line. Link [➙ 110]**
   If detectors have been swapped over or are missing, the following messages are shown on the display of the Person Machine Interface:
   'Zone', 'Serial no. ("ID-Nr.")', 'Dev.location fault'

   The work described in this chapter may be performed when the C-NET detector line is switched on.

### 12.2.1 Switch off zone

1. Select 'Topology' > ↑ 'Detection tree' > ↑ 'Area' > ↑ 'Section' > ↑ 'Zone' in the main menu.
2. Press the 'More Options' softkey and select 'Execute commands'.
3. **WARNING! System parts that have been switched off make it impossible to acquire and process alarms or faults!** Select the 'Off' command.
   - The yellow 'ISOLATION' LED lights up.
   - The 'Zone' is switched off.

### 12.2.2 Removing devices, performing tasks and re-inserting devices

Mark the allocation of the devices to the respective base to avoid additional work steps.

1. Remove the devices from their bases.
2. Perform the tasks.
3. Re-insert the devices to the respective position.

### 12.2.3 Switch on zone

1. Select 'Topology' > ↑ 'Detection tree' > ↑ 'Area' > ↑ 'Section' > ↑ 'Zone' in the main menu.
2. Press the 'More Options' softkey and select 'Execute commands'.
3. Select the 'On' command.
   - The yellow 'ISOLATION' LED goes out.
   - The 'Zone' is switched on.
12.3 Permanently removing non-stationary C-NET devices

You will find additional information about the individual steps on the specified pages.

1. Switch the C-NET detector line off. Link [➔ 109]
2. Remove the C-NET devices and their bases. Link [➔ 111]
3. Switch the C-NET detector line on. Link [➔ 109]
4. Delete the C-NET devices individually via the ↑ Person Machine Interface on the control panel. Link [➔ 112]
5. Connect the PC to the ↑ 'Station'. Link [➔ 79]
6. Load the configuration from the 'Station' to the PC. Link [➔ 84]
7. Remove the logical elements in Cerberus-Engineering-Tool. Link [➔ 112]
8. Load the configuration from the PC to the 'Station'. Link [➔ 82]
9. Disconnect the PC from the 'Station'. Link [➔ 79]

You can find information about the individual steps in the chapters referenced below.

12.4 Replacing non-stationary C-NET devices of the same type

Procedure

- Switching on test mode
- Replace C-NET device
- Switch on normal operation
- Connect PC to the 'Station'
- Load configuration from the 'Station' to the PC
- Disconnect PC from the 'Station'

You will find information about the individual steps in the following chapters and the chapters to which reference is made below.

12.4.1 Replacing the C-NET device

1. Remove the C-NET device you want to replace from the base.
2. Wait approx. 20 seconds.
3. Insert the new C-NET device of the same type.
   ⇐ The internal alarm indicator flashes for 10 seconds following successful replacement.

Proceed as follows if the alarm indicator does not flash:

1. Ensure that you wait long enough before inserting.
2. Check whether other C-NET devices are missing on the detector line.
3. Check whether a device that is not of the same type has been inserted. If this is the case, insert a device of the same type.
4. Restart the C-NET line.
12.5 Replacing non-stationary C-NET devices of different types

Procedure
- Detach C-NET device
- Delete C-NET device on Person Machine Interface
- Installing a new C-NET device
- Read in C-NET devices. This step need only be performed once.
- Connect PC to the 'Station'
- Load configuration from the 'Station' to the PC
- Replace C-NET device in the 'Zone'
- Load configuration from the PC to the 'Station'
- Disconnect PC from the 'Station'

You will find information about the individual steps in the following chapters and the chapters to which reference is made below.

12.5.1 Removing the C-NET device
- Uninstall the device you want to replace.
  - The 'Station' detects that the device is missing and reports a 'Fault'.

You will find more information about installing and uninstalling in the documentation for the corresponding 'C-NET' device.

12.5.2 Installing the C-NET device
- Install the new C-NET device.

You will find more information about installing in the documentation for the corresponding 'C-NET' device.

12.5.3 Replacing C-NET device in the 'Zone'

1. Select the 'Zone' in which you have replaced a device in Cerberus-Engineering-Tool. The 'Find' or 'Find and replace' functions can be used to do this.

2. Replace the C-NET device.

You will find more information in document A6V10210424. See chapter 'Applicable documents'.
13 Testing the installation
The fire detection installation can be switched to 'Test' operation mode to check it is functioning properly.

13.1 Testing
FS720 offers various test functions for efficient testing of devices and logical functions. Some test methods can be combined, others have to be carried out individually.

The fire detection installation is in 'Test' operation mode if one of the following test modes is activated:
- 'Detector test'
- 'Walk test'
- 'Control test'
- 'Installation test'
- Test variants

You will find more information on testing the system in document A6V10211076. See chapter 'Applicable documents'.
### 13.2 Checking functions

The table below shows the recommended intervals for checking functions. National specifications always take priority.

For details of the function test, refer to the 'Applicable documents' chapter.

<table>
<thead>
<tr>
<th>Function</th>
<th>Activity</th>
<th>Interval (years)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Check date and time.</td>
<td>X</td>
</tr>
<tr>
<td>Detector lines:</td>
<td>Trigger an automatic detector and a manual call point per line.</td>
<td>X</td>
</tr>
<tr>
<td>• C-NET</td>
<td>Trigger all manual call points</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Trigger all automatic fire detectors.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Check all detectors for soiling and application.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Check the function of the input/output modules.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>On each line check whether short-circuit / open line triggers a 'Fault'.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Check the loop line function.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>During short-circuit also check the separator function.</td>
<td></td>
</tr>
<tr>
<td>Fire controls</td>
<td>Check activation of the controls up to and with the interface.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Check isolations carried out by the customer. Arrange a time with the customer.</td>
<td>X</td>
</tr>
<tr>
<td>Degraded function</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Mains failure</td>
<td>Check 'Delayed for in case of a mains failure' function.</td>
<td>X</td>
</tr>
<tr>
<td>Alarm organization</td>
<td>Check the function of the delay times t1 and t2.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Alarm activation by automatic detector on 'unmanned'</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>⇒ Global alarm.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alarm activation by manual call point on 'manned' and 'unmanned'</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>⇒ Local alarm/global alarm.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Check automatic switchover 'Manned'/ 'Unmanned' on the basis of the event memory entry.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Check activation of the remote transmission equipment with 'Alarm'.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Actuate the corresponding danger level by activating a detector with the detector exchanger and tester</td>
<td>X</td>
</tr>
<tr>
<td>Alarm devices</td>
<td>In emergency power operation check all alarm devices taking the event category into account:</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>'Pre-alarm'</td>
<td></td>
</tr>
<tr>
<td></td>
<td>'Alarm'</td>
<td></td>
</tr>
<tr>
<td></td>
<td>'Fault'</td>
<td></td>
</tr>
</tbody>
</table>
Glossary

**Alarm indicator**
Visual display to signal an alarm or pre-alarm.

**Area**
The top level in the detection tree. Sections and zones are assigned to the area.

**Auto-configuration**
A zone is created for each sensor channel (automatic detector and manual call point). A control is created for each alarm sounder. IO-modules, FT2010, FT2011, and external alarm indicators are not auto-configured.

**Automatic fire detector**
Device which measures a physical parameter (e.g. warmth) in order to detect a fire.

**BDV**
Abbreviation for 'Base Data Variant'. Configuration files for the embedded software. A BDV contains country-specific templates, all texts, specifications for message layout, menu definitions, specifications for activating the LEDs on the PMI, detector parameter set settings, definitions for system-specific parts of the tool interface, etc.

**C-NET device**
A device connected to the C-NET detector line.

**CPU**
Abbreviation for 'Central Processing Unit'. The computing unit of the fire control panel.

**Danger level**
A fire detector signal which conveys the possibility of fire. Automatic fire detectors, for example, have danger levels 0 to 3. Manual call points only have danger levels 0 and 3. 0 = no danger, 1 = possible danger, 2 = probable danger, 3 = highly probable danger.

**Detection tree**
Diagram of the geographical and organizational arrangements of sensors in a building. This is a hierarchical structure comprising the area, section, and zone.

**Detector line**
Electrical connection between the detectors and the fire control panel. There are collective detector lines and addressed detector lines.

**External alarm indicator**
Optical element for displaying the fire location, which is at some distance from the detector. It is normally mounted in the room at the point where the corresponding detector is accessible.

**FDnet**
Addressed detector line for FDnet devices.

**FDnet device**
A device connected to the FDnet detector line.
Hardware tree
Depiction of the hardware of a fire detection installation.

Line card
Card for connecting peripheral devices. The card can be a plug-in card or it can be integrated into the periphery board.

Logical channel
Depiction of a logical device function in the detection or control tree. The logical channel is always the bottom level in the structure tree.

Loop
Detector line topology which runs from the fire control panel via the fire detectors and back to improve operational reliability. This type of wiring allows all detectors to communicate with the control panel even in the event of an open line or short-circuit.

Normal operation
The fire detection installation is supplied with mains voltage.

Parameter set
Defined detector behavior, e.g. in terms of sensitivity, resistance to deceptive phenomena, response time. Detectors can be operated with different parameter sets.

Physical channel
Depiction of a device's physical function in the hardware tree. The physical channel is always the bottom level in the hardware tree.

PMI
The arrangement of operating and display elements on a fire control panel or on a fire terminal. Includes the LEDs, buttons, the display, and the operation options such as the key switch, fire brigade control and display (FBA), and the EVAC NL Person Machine Interface.

Pre-alarm
Stage before an alarm for information early on, should an event occur.

Section
Level in detection tree of the fire detection system. The section is assigned to the area. It is used for combining zones.

Site
Depiction of fire detection installation: The top level in the figure showing the installed system. Combines hardware tree, detection tree, and control tree.

Soft keys
Soft keys are buttons which you can use to carry out functions and which are displayed in the three fields of the softkey line on the display. These three black fields contain the names of the functions in white font. The functions of the softkeys change dynamically depending on the situation and the contents of the display. Always the most important functions are assigned to the softkeys 1 and 2.

Standalone station
Standalone station with local connection for the PC.
**Station**
Unit for system control. Fire control panel or fire terminal.

**Stub**
Detector line which is only connected to the fire control panel on one side. In the event of an open line or short-circuit, it may no longer be possible for all fire detectors to communicate with the fire control panel.

**Zone**
Level in the detection tree. The zone has at least one fire detector. The decision on alarm is made at zone level. The zone is assigned to a section or an area.
## Index

### A
- **Access levels**
  - Setting the PIN .............................................. 115
- **Alarm indicator, external** .................................. 71
- **Auto-configuration**
  - Detector line ................................................ 107
  - Station ..................................................... 106
- **Automatic**
  - Line calibration .......................................... 99

### B
- **Backup** ........................................................ 84
- **Battery backup** ............................................. 46

### C
- **Calculation variables**
  - Line calibration ............................................. 101
- **Calibrating lines manually** ................................ 100
- **Calibration modes**
  - Line calibration .......................................... 98
- **Calibration report**
  - General ..................................................... 100
  - Indicators .................................................. 100
  - Line calibration ........................................... 100, 100
- **Configuration**
  - Load to station ........................................... 79, 82
  - Loading to PC .............................................. 84
- **Connection to the station** .................................. 76
- **Connectivity** ................................................ 76
- **Customer text**
  - Entering / changing ...................................... 92
  - Entry of characters ....................................... 75

### D
- **Date**
  - Set .................................................................. 93
- **Deleting**
  - Device .......................................................... 112
- **Detector**
  - Test mode .................................................... 113
  - Testing ........................................................ 112
- **Detector line** ................................................. 63
  - Auto-configuration ......................................... 107
  - Restart ....................................................... 110
  - Switch off ................................................... 109
  - Switching on ................................................ 109
- **Device**
  - Remove ........................................................ 116
  - Replacing (different types) ............................... 119
  - Replacing (same type) ..................................... 118
  - Temporarily remove ....................................... 116
- **Display**
  - How displays are represented in the document ....... 12
- **Download** .................................................. 79, 82
- **Download center**
  - URL ............................................................ 9

### E
- **Entering characters**
  - Keypad ........................................................ 75
- **Entries in the calibration report**
  - Line calibration ........................................... 102
- **Entry of characters**
  - Numbers, letters (customer text) ....................... 75
- **External alarm indicator** .................................. 71

### F
- **Favorite**
  - PMI ............................................................. 74
  - FCA2014-A1 .................................................. 41
  - FDnet/C-NET detector line
    - Removing a device (non-stationary) .................. 118
  - FHA2016-A1 .................................................. 42
- **Firewall**
  - Windows 7 ................................................... 77
  - Windows firewall .......................................... 76
  - Windows XP .................................................. 76
- **Function test** .............................................. 115
- **Fuse** ........................................................ 84

### G
- **General**
  - Calibration report ........................................... 100
  - Line calibration ........................................... 97
- **Guideline**
  - PIN ............................................................ 17

### H
- **Hardware reset**
  - Station ....................................................... 96

### I
- **Indicators**
  - Calibration report ......................................... 100
Initialize
Station ..........................................................  80

K
Key figures
Line calibration .............................................  101
Keypad
Entry of characters ..........................................  75

L
Line
Auto-configuration ........................................  88, 107
Restart ..........................................................  110
Line calibration
Automatic .......................................................  99
Calibrating lines manually ................................  100
Calibration modes ..........................................  98
Calibration report ..........................................  100
Displaying the calibration report .....................  100
Entries in the calibration report ......................  102
Figures and calculation variables ..................  101
General ..........................................................  97
Manual ...........................................................  99
Time ...............................................................  98
Load
From PC to station ....................................  79, 82
From station to PC ..........................................  84
Load data to PC
Site .................................................................  84
Load data to the station
Site .................................................................  82
Localization error ...........................................  115
Log in ............................................................. 87
Login .............................................................. 87

M
Manual
Line calibration ...............................................  99

N
Normal operation ...........................................  114
Numeric key
Shortcut ..........................................................  74

O
Operating function
Scrolling .........................................................  73
Selection and opening / execution ....................  73
Original language ..........................................  8

P
PC
Connect to station ............................................  78
Disconnecting from station ................................  79
PIN ...............................................................  87
Guideline ........................................................  17
Input dialog ...................................................  87
Manage, create, delete, change ......................  94
Releasing an access level ................................  87
PMI
Favorite ..........................................................  74
Power supply
with battery backup ........................................  46
without battery backup ...................................  46
Preparation
Station ..........................................................  105
Preparation without BDV
Station ..........................................................  106
R
Read in
Device ..........................................................  111
Releasing an access level ................................  87
Remove
Device ..........................................................  116
Device (temporary) ..........................................  116
Removing a device (non-stationary)
FDnet/C-NET detector line ..............................  118
Replace
Device (different types) ...................................  119
Device (same type) ..........................................  118
Restart
Detector line .................................................  110
Station ............................................................  96
Scroll
Indication of the position and length of the list ....  74
Scroll bars ......................................................  74
Scroll in option lists, command lists, element category lists ........................................  73
Set
Date and time .................................................  93
Setting the PIN
for access levels ...........................................  115
Shortcut ..........................................................  74
Signal transmitter ...........................................  63
Site
Load data to PC ..............................................  84
Load data to the station ..................................  82

126 | 128
Building Technologies
Fire Safety
A6V10211100_g_en--
2018-06-25
Source language ............................................... 8
Start
  Detector line ............................................... 110
Station
  Auto-configure ............................................. 106
  Hardware reset ........................................... 96
  Initialize .................................................... 80
  Load data ................................................... 79
  Preparation .................................................. 105
  Preparation without BDV ............................... 106
  Restart ....................................................... 96
Switch off
  Detector line ............................................... 109
Switching on
  Detector line ............................................... 109
Testing
  Detector .................................................... 112, 112
Time
  Line calibration ............................................ 98
  Set ............................................................ 93
U
Uninstalling
  Device ......................................................... 111
Upload .......................................................... 84
W
Windows 7
  Firewall ...................................................... 77
Windows firewall .......................................... 76
Windows XP
  Firewall ...................................................... 76
Z
Zone
  Switch off .................................................. 109, 117
  Switching on ................................................. 109, 117